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பகுதி – அ 

I சரி஬ான வி௅ை௅஬த்    ந்௃ெடுத்து ஋ழுதுக. 

1 
DTP ஋ன்பென் விரிலாக்கம்  

 ) Desktop Publishing      ) Desktop publication      ) Doctor to Patient        ஈ) Desktop Printer 

2 
_________ ஋ன்பது எரு DTP ௃஫ன்௃பாருராகும்.   

 ) Lotus 1-2-3     ) PageMaker      ) Maya     ஈ) Flash 

3 
஋ந்ெ பட்டியில் New கட்ை௅ர இைம் ௃பற்றுள்ரது?  

 ) File menu       ) Edit menu      ) Layout menu     ஈ) Type menu 

4 

Page Maker சன்னல் தி௅஭யில் கருப்பு நிம ஋ல்௅யக்௄காட்டிற்கு ௃லளியில் இருக்கும் பகுதி 

__________ ஋ன அ௅றக்கப்படும்  

 ) page     ) pasteboard        ) blackboard      ஈ) dashboard 

5 
PageMaker ஆலணத்௅ெ மூடுலெற்கான வி௅சப்பய௅க குறுக்கு லழி_________  

 ) Ctrl+A      ) Ctrl +B         ) Ctrl+C       ஈ) Ctrl+W 

6 
_________ கருவி ஆலணத்தின் எரு பகுதி௅஬ப் ௃பரிொக்கிப் பார்க்கப் ப஬ன்படுகிமது.  

 ) Text tool       ) Line tool      ) Zoom tool      ஈ) Hand tool 

7 
௃பட்டிகள் ல௅஭லெற்குப் ப஬ன்படும் கருவி _________  

 ) Line       ) Ellipse      ) Rectangle       ஈ) Text 

8 
Place கட்ை௅ர _________பட்டியில் இைம் ௃பற்றிருக்கும்  

 ) File          ) Edit        ) Layout      ஈ) Window 

9 

முழு ஆலணத்௅ெத் ௄ெர்ந்௃ெடுக்க விரசப்பய௅கயில் ____குறுக்கு லழி சாவி    ஫ானத்௅ெ 

அழுத்ெ ௄லண்டும். 

 ) Ctrl+A       ) Ctrl +B       ) Ctrl+C      ஈ) Ctrl+D 

10 
஋ழுத்து லடிவூட்ைல் கீழ்க்கண்ைலற்றில் ஋ந்ெ பண்புக௅ரப் ௃பற்றிருக்கும்?  

 ) Bold       ) Italic       ) Underline      ஈ) All of these 

11 
உ௅஭௅஬ பதிப்பிக்க ப஬ன்படும் கருவி ஋து?  

 ) Text tool     ) Type tool    ) Crop tool   ஈ) Hand tool 

12 
PageMaker இல் ஆலணத்௅ெ அச்சிைப் ப஬ன்படும் வி௅சப்பய௅க குறுக்கு லழி _________  

 ) Ctrl+A      ) Ctrl +P       ) Ctrl+C     ஈ) Ctrl+V 

13 அ௄ைாப் ௄பஜ்௄஫க்கர் ஋ன்பது பக்க லடில௅஫ப்பு ௃஫ன்௃பாருராகும். 

14 ெ௅யப்புப் (Title bar) பட்௅ை ௄பஜ்௄஫க்கர் ஆலணத்தின் ௄஫ல்பகுதியில் இருக்கும். 

15 
ஆலணத்௅ெ ௄஫லும் கீழு஫ாகவும், இைது ஫ற்றும் லயது பும஫ாகவும் நகர்த்துல௅ெ தி௅஭ உருரல் 

பட்௅ை (Scrolling bar)   ஋ன்கி௄மாம்.   

16 Ellipse Tool கருவி லட்ைம் ல௅஭லெற்குப் ப஬ன்படுகிமது. 

17 Layout பட்டி௅஬க் கிளிக் ௃சய்து Insert Pages விருப்பத்௅ெப் ௃பமயாம். 

18 

௃பாருத்துக. 

அ) Cut    (iii)  Ctrl+X 

ஆ) Copy (iv) Ctrl+C  

இ) Paste (ii)  Ctrl+V  

ஈ) Undo   (i)  Ctrl+Z 
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19 

கீழ்க்கண்ைலற்றில் ௃பாருந்ொெ என்௅மத்    ந்௃ெடு.  

i. Adobe PageMaker, QuarkXPress, Adoble InDesign, Audacity 

ii. File, Edit, Layout, Type, Zip 

iii. Pointer Tool, Line Tool, Hide Tool,Hand Tool 

iv. Bold, Italic, Portrait, Underline. 

20 

கீழ்க்கண்ைலற்றில் சரி஬ான கூற்௅மத் ௄ெர்ந்௃ெடு.  

i.  )                                      . 

   )                                              . 

ii.  ) DTP               Desktop publishing. 

   ) DTP               Desktop publication. 

21 

கீழ்க்கண்ைலற்றில் சரி஬ான இ௅ண௅஬த் ௄ெர்ந்௃ெடு.  

i.  ) Edit Cut 

   ) Edit New 

ii.  ) Undo Copy 

   ) Undo Redo 

பகுதி ஆ 

II மூன்று லரிகளில் வி௅ை஬ளிக்கவும். 

1 

Desktop Publishing ஋ன்மால் ஋ன்ன?  

DTP ஋ன்பென் விரிலாக்கம் Desktop publishing. DTP ௃஫ன்௃பாரு௅ர ப஬ன்படுத்தி 

ஆலணங்களுக்கான பக்கங்க௅ர லடில௅஫ப்பு ௃சய்லொகும். 

2 

DTP ௃஫ன்௃பாருள்களுக்கு ஋டுத்துக்காட்டுகள் ெருக?  

DTP ௃஫ன்௃பாருள்கள் சிய அ௄ைாப் ௄பஜ்௄஫க்கர் (Adobe Pagemaker), அ௄ைாப் இன்டி௅சன் (Adobe 

in Design), குலார்க் ஋க்ஸ்பி஭ஸ் (Quark Xpress) 

3 

௄பஜ்௄஫க்கர் ௃஫ன்௃பாரு௅ர திமப்பெற்கான லழிமு௅மக௅ரக் கூறு?  

Start → All Programs → Adobe → PageMaker7.0 → Adobe PageMaker 7.0 ஋ன்ப௅ெ கிளிக் 

௃சய்து திமக்க முடியும். 

4 

௄பஜ்௄஫க்கர் ௃஫ன்௃பாருளில் எரு புதி஬ ஆலணத்   ஋வ்லாறு திமக்கயாம்?  

1. File-New (அல்யது) Ctrl+N ஋ன்ப௅ெ கிளிக் ௃சய்.  

2. உ௅஭஬ாைல் ௃பட்டி ௄ொன்றும். அரவுக௅ர உள்ளீடு ௃சய்.  

3. OK ௃பாத்ொ௅ன கிளிக் ௃சய். 

5 

எட்டுபய௅க ஋ன்மால் ஋ன்ன?  

கருப்பு நிம ஋ல்௅யக் ௄காட்டிற்கு ௃லளியில் உள்ர பகுதி எட்டுப்பய௅க ஋னப்படும். 

எட்டுபய௅கயில் ௅லக்கப்படும் ஋துவும் அச்சிடும்௄பாது ல஭ாது. லடில௅஫ப்பு கருவிக௅ர ௅லக்க 

எட்டுபய௅க௅஬ ப஬ன்படுத்ெயாம். 

6 

௄பஜ்௄஫க்கரில் உள்ர பட்டிப்பட்௅ை பற்றி குறிப்பு ஋ழுதுக?  

File, Edit, Layout, Type, Element, Utilities, View, Window, Help ௄பான்ம பட்டிக௅ர ௃காண்டுள்ரது. 

பட்டி௅஬ கிளிக் ௃சய்ொல் து௅ணப்பட்டி஬ல் ௄ொன்றும். 

7 

஋லிப்ஸ் டூல் ஫ற்றும் ஋லிப்ஸ் ஃபி௄஭ம் டூல் ௄லறுபடுத்துக. 

஋லிப்ஸ் டூல் ஋லிப்ஸ் ஃபி௄஭ம் டூல் 

லட்ைம், நீள் லட்ைம் ல௅஭஬ப் 

ப஬ன்படுகிமது.  

உ௅஭ ஫ற்றும் ல௅஭க௅ய ௅லப்பெற்கான 

நீள்லட்ைங்க௅ர ல௅஭஬ ப஬ன்படுகிமது.   

8 

உ௅஭ பதிப்பித்ெல் ஋ன்மால் ஋ன்ன? 

ஆலணத்தில் உ௅஭௅஬ ௄சர்த்ெல், நீக்குெல், பி௅ற திருத்துெல், நகர்த்துெல் ஫ற்றும் நகல் ஋டுத்ெல் 

௄பான்ம ௃ச஬ல்பாடுக௅ர ௃சய்ெல் உ௅஭ பதிப்பித்ெல் ஋ன்று ௃ப஬ர். உ௅஭யில் ஫ாற்மங்கள் 

௃சய்ெல் உ௅஭ பதிப்பித்ெல் ஋ன்று ௃ப஬ர். 

www.Padasalai.Net                                                                   www.CBSEtips.in

Kindly send me your study materials to our email id - padasalai.net@gmail.com

Pa
da

sa
la

i.N
et

Pa
da

sa
la

i.N
et

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://www.padasalai.net/
https://www.padasalai.net/


 
 

 5 M.Sc.,M.Ed.,M.Phil.,  

 

9 

உ௅஭ ௃ொகுதி ஋ன்மால் ஋ன்ன?  

உ௅஭த் ௃ொகுதி ஋ன்பது நாம் ெட்ைச்சு ௃சய்ெ உ௅஭௅஬ அல்யது எட்டி஬ உ௅஭௅஬ அல்யது ௄லறு 

ஆலணத்தில் இருந்து ௃காண்டு ௅லப்பட்ை உ௅஭௅஬ ௃காண்டிருக்கும். 

10 

௃ொைர்புள்ர உ௅஭த் ௃ொகுதி ஋ன்மால் ஋ன்ன?  

எரு உ௅஭த் ௃ொகுதியில் உள்ர உ௅஭௅஬ ஫ற்௃மாரு உ௅஭த் ௃ொகுதிக்குள் ௃சல்லு஫ாறு 

அ௅஫க்க முடியும். எரு உ௅஭த் ௃ொகுதி௅஬ ஫ற்௃மாரு உ௅஭த்௃ொகுதியுைன் இரணக்க௄லா 

அல்யது ௃ொைர்பு படுத்ெ௄லா ௃சய்஬ முடியும். இவ்லாறு ௃ொைர்பு படுத்ெப்பட்டிருக்கும் 

உ௅஭த்௃ொகுதிகளுக்கு ௃ொைர்புள்ர உ௅஭த்௃ொகுதி ஋ன்று ௃ப஬ர். 

11 

௃ொைர்புள்ர உ௅஭ ஋ன்மால் ஋ன்ன?  

உ௅஭த் ௃ொகுதிகளுக்கு இ௅ை௄஬ உள்ர உ௅஭௅஬ இ௅ணக்கும் ௃ச஬ல்பாட்டிற்கு ௃ொைர்புள்ர 

உ௅஭ ஋ன்று ௃ப஬ர். 

12 

௄பஜ்௄஫க்கரில் புதி஬ பக்கங்க௅ர ஋வ்லாறு ௃சருகயாம்?  

1. Layout-Insert Pages ஋ன்ப௅ெ கிளிக் ௃சய்  

2. உ௅஭஬ாைல் ௃பட்டி ௄ொன்றும்  

3. Insert உ௅஭ப்௃பட்டியில் ௄சர்க்க ௄லண்டி஬ பக்க ஋ண்ணிக்௅க௅஬ ெ஭வும்  

4. After (அ) Before ஋ன்ப௅ெ ௄ொோ்வு ௃சய்  

5. Insert ௃பாத்ொ௅ன கிளிக் ௃சய். 

பகுதி இ 

III எரு பத்தி஬ரவில் வி௅ை஬ளிக்கவும்.  

1 

௄பஜ்௄஫க்கர் ஋ன்மால் ஋ன்ன? அென் ப஬ன்க௅ர கூறுக?  

௄பஜ்௄஫க்கர் ஋ன்பது எரு பக்க லடில௅஫ப்பு ௃஫ன்௃பாருள் ஆகும்.  

ப஬ன்கள்:  

 பக்கங்க௅ர லடில௅஫க்க ப஬ன்படுகிமது.  

 சிறி஬ அட்௅ை முெல் ௃பரி஬ புத்ெகம் ல௅஭ லடில௅஫க்கராம்.  

஋ளிொக உ௅஭, ல௅஭க௅ய லடிலங்க௅ர ௄சர்க்கயாம். 

2 

௄பஜ்௄஫க்கரில் உள்ர ஌௄ெனும் மூன்று கருவிக௅ரயும் அென் வி௅சப்பய௅க குறுக்கு 

லழிக௅ரயும் கூறுக? 

கருவிகள் குறுக்கு லழி 

௃஭ாட்௄ைட்டிங் டூல் (Rotataing Tool)  Shift + F2  

௅யன் டூல் (Line Tool)  Shift + F3  

௃஭க்ைாங்கில் டூல் (Rectangle Tool)  Shift + F4  

஋லிப்ஸ் டூல் (Ellipse Tool)  Shift + F5  

பாலிகான் டூல் (Polygon Tool)  Shift + F6   
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3 

௄பஜ்௄஫க்கரில் உள்ர ஌௄ெனும் மூன்று கருவிகளின் குறும்பைங்க௅ரயும் அென் ப஬ன்க௅ரயும் 

கூறுக?  

கருவி ப஬ன்கள் குறும்பைம் 

௅யன் டூல் ௄நர் ௄காடு ல௅஭஬  

கன்ஸ்௃஭ய்ன்டு ௅யன் டூல் கி௅ை஫ட்ை, ௃சங்குத்து ௄காடு ல௅஭஬  

௃஭க்ைாங்கில் டூல் சது஭ம், ௃சவ்லகம் ல௅஭஬  

஋லிப்ஸ் டூல் லட்ைம், நீள்லட்ைம் ல௅஭஬  

பாலிகான் டூல் பய௄காணம் ல௅஭஬  

ஜும் டூல் பக்க அர௅ல ௃பரிொக, சிறிொக ஫ாற்ம  

௃ைக்ஸ்ட் டூல் உ௅஭ உள்ளிை   

4 

பிரிக்கப்பட்ை உ௅஭த்௃ொகுதி௅஬ ஋வ்லாறு ௄சர்ப்பாய்?  

 ௃சருகும் புள்ளி௅஬ இ஭ண்ைாலது உ௅஭த்௃ொகுதியின் கீழ்பக்க ௅கப்பிடியில் கிளிக் ௃சய்து 

௄஫ல்பகுதி ல௅஭ இழுக்கவும்  

 ௃சருகும் புள்ளி௅஬ முெல் உ௅஭த்௃ொகுதியின் கீழ்பக்க ௅கப்பிடியில் கிளிக் ௃சய்து 

௄஫ல்பகுதி ல௅஭ இழுக்கவும். 

5 

உ௅஭ உள்ர சட்ைங்க௅ர ஋வ்லாறு இ௅ணப்பாய்?  

• இ஭ண்ைாலது சட்ைம் ல௅஭஬ ௄லண்டும்  

• முெல் சட்ைத்௅ெ கிளிக் ௃சய்  

• கீழ்பக்க ௅கப்பிடியில் உள்ர சிலப்பு முக்ககாணத்௅ெ கிளிக் ௃சய்  

• இ஭ண்ைாலது சட்ைத்௅ெ கிளிக் ௃சய் 

6 

஫ாஸ்ைர் பக்கத்தின் ப஬ன் ஋ன்ன?  

஫ாஸ்ைர் பக்கத்தில் ௅லக்கப்படும் ஋ந்ெ எரு ௃பாருளும் ஆலணத்தில் உள்ர ஋ல்யா பக்கங்களிலும் 

௄ொன்றும். எவ்௃லாரு பக்கங்களிலும் ௃பாரு௅ர ௄சர்க்க ௄ெ௅லயில்௅ய.  

஫ாஸ்ைர் பக்கம் ெ௅யப்பு, அடிக்குறிப்பு, பக்க ஋ண்கள், ௄யா௄காக்கள் ஆகி஬லற்௅ம ௃காண்டுள்ரது.  

7 

஫ாஸ்ைர் பக்கத்தில் பக்க ஋ண்க௅ர ஋வ்லாறு ௄சர்ப்பாய்?  

1. Master Pages பணிக்குறி௅஬ கிளிக் ௃சய்  

2. T பணிக்குறி௅஬ கிளிக் ௃சய்  

3. இைது ஫ாஸ்ைர் பக்கத்௅ெ கிளிக் ௃சய்  

4. Ctrl + Alt + P ஋ன்ப௅ெ கிளிக் ௃சய்  

5. பக்க ஋ண் LM ஋ன ௄ொன்றும்  

6. லயது ஫ாஸ்ைர் பக்கத்௅ெ கிளிக் ௃சய்  

7. Ctrl + Alt + P ஋ன்ப௅ெ கிளிக் ௃சய்  

8. பக்க ஋ண் RM ஋ன ௄ொன்றும் 
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பகுதி ஈ 

IV எரு பக்க அரவில் வி௅ை஬ளிக்கவும். 

1 

௄பஜ்௄஫க்கர் கருவிப்பட்டியிலுள்ர கருவிக௅ரப் பற்றி விலரி. 

பாயின்ைர் டூல் 
உ௅஭ ஫ற்றும் ல௅஭க௅யப் பைங்க௅ரத் ௄ெர்ந்௃ெடுக்க, 

நகர்த்ெ, அர௅ல ஫ாற்ம 

௃ைக்ஸ்ட் டூல் உ௅஭௅஬ உள்ளிை, ௄ெர்ந்௃ெடுக்க, பதிப்பிக்க 

௃஭ாட்௄ைடிங் டூல் ௃பாருள்க௅ர ௄ெர்ந்௃ெடுக்க ஫ற்றும் சுறற்ம 

கி஭ாப்பிங் டூல் ல௅஭க௅யக௅ர எழுங்க௅஫க்க 

௅யன் டூல் ௄நர்௄காடு ல௅஭஬ 

கன்ஸ்௃஭ய்ன்டு ௅யன் டூல் கி௅ை஫ட்ை஫ாகவும், ௃சங்குத்ொகவும் ௄காடுகள் ல௅஭஬ 

௃஭க்ைாங்கல் டூல் சது஭ம் ஫ற்றும் ௃சவ்லகம் ல௅஭஬ 

௃஭க்ைாங்கல் ஃபி௄஭ம் டூல் 
உ௅஭ ஫ற்றும் ல௅஭க௅யக௅ர ௅லப்பெற்கான 

௃சவ்லகங்க௅ர ல௅஭஬ 

஋லிப்ஸ் டூல் லட்ைம் ஫ற்றும் நீள்லட்ைம் ல௅஭஬ 

஋லிப்ஸ் ஃபி௄஭ம் டூல் 
உ௅஭ ஫ற்றும் ல௅஭க௅யக௅ர ௅லப்பெற்கான 

நீள்லட்ைங்க௅ர ல௅஭஬ 

பாலிகான் டூல் பய௄காணங்கள் ல௅஭஬ 

பாலிகான் ஃபி௄஭ம் டூல் 
உ௅஭ ஫ற்றும் ல௅஭க௅யக௅ர ௅லப்பெற்கான 

பய௄காணங்கள் ல௅஭஬ 

௄ேண்ட் டூல் பக்கத்௅ெ தி௅஭ உருரல் ௃சய்஬ 

ஜூம் டூல் பக்கத்தின் அர௅ல ௃பரிொக்கியும் சிறிொக்கியும் பார்க்க 
 

2 

சட்ைத்தில் உ௅஭௅஬ ௅லப்பெற்கான லழிமு௅மக௅ரக் கூறு. 

• கருவிப்௃பட்டியில் உள்ர ஌௄ெனும் எரு பி௄஭ம் டூ௅ய ௄ொோ்வு ௃சய்஬௄லண்டும். 

• அ௅ெப் ப஬ன்படுத்தி எரு சட்ைம் ல௅஭஬ ௄லண்டும். 

• அச்சட்ைத்௅ெ ௄ொோ்வு ௃சய்஬ ௄லண்டும். 

• File Place ஋ன்ப௅ெ ௄ெர்வு ௃சய்஬ ௄லண்டும். Place உ௅஭஬ாைல் ௃பட்டி ௄ொன்றும். 

• அதில் ௃சருக ௄லண்டி஬ உ௅஭௅஬ ௄ெர்வு ௃சய்஬ ௄லண்டும். 

• Open ௃பாத்ொ௅ன கிளிக் ௃சய்஬ ௄லண்டும். 

• உ௅஭஬ானது சட்ைத்தில் ௃சருகப்பட்டுவிடும். 

3 

உ௅஭த் ௃ொகுதியிலுள்ர உ௅஭௅஬ சட்ைத்திற்கு ஋வ்லாறு ஫ாற்றுலாய்? 

• கருவிப்௃பட்டியில் உள்ர ஃபி௄஭ம் டூல்களில் ஌௄ெனும் என்௅ம ப஬ன்படுத்தி சட்ைம் என்௅ம 

ல௅஭஬வும்.  

• ௃சருக ௄லண்டி஬ உ௅஭த்௃ொகுதி௅஬ ௄ெர்ந்௃ெடுக்க ௄லண்டும்.  

• Shift ௃பாத்ொ௅ன அழுத்திக் ௃காண்டு சட்ைத்௅ெ கிளிக் ௃சய்஬ ௄லண்டும். 

• Element  Frame  Attach Content ஋ன்ப௅ெ கிளிக் ௃சய்஬ ௄லண்டும். 

• உ௅஭஬ானது சட்ைத்திற்கு உள்௄ர ௄ொன்றும். 

4 

பாலிகான் டூ௅யப் ப஬ன்படுத்தி எரு நட்சத்தி஭ம் ல௅஭லெற்கான லழிமு௅மக௅ரக் கூறு. 

• கருவிப் ௃பட்டியில் பாலிகான் டூ௅ய ௄ெர்வு ௃சய்஬ ௄லண்டும்.  

• தி௅஭யில் சுட்டி௅஬ அழுத்திக் ௃காண்டு பாலிகான் ல௅஭஬ ௄லண்டும்.  

• Element  Polygon Settings ஋ன்ப௅ெத் ௄ெர்வு ௃சய்஬ ௄லண்டும்.  

• Polygon Settings உ௅஭஬ாைல் ௃பட்டி ௄ொன்றும்  

• Number of Side உ௅஭ப்௃பட்டியில் 5 ஋ன உள்ளிை ௄லண்டும். 

• Star inset உ௅஭ப்௃பட்டியில் 50% ஋ன ெட்ைச்சு ௃சய்஬ ௄லண்டும்.  

• OK ௃பாத்ொ௅ன அழுத்ெவும் தி௅஭யில் நட்சத்தி஭ம் ௄ொன்றும். 
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பகுதி - அ 

I சரி஬ான வி௅ை௅஬த்    ந்௃ெடுத்து ஋ழுதுக. 

1 
என்று அல்யது அெற்கு ௄஫ற்பட்ை சட்ைங்க௅ர ஆக்கி஭மித்திருக்கும் ௃ொைர்ச்சி஬ான உ௅஭  

 )     (story)       )     (paragraph)       )       (object)     ஈ)     (plate ) 

2 
In Design-னுள்ர எவ்௃லாரு உ௅஭யின் துண்டுப் பகுதியும்  

 )           ( text frame )    )      (shape)    )        (clipboard) ஈ)         

3 

ஆலணத்௅ெச் சுற்றியுள்ர பகுதி 

 )          ( paste board )    )            (white space) 

 )           (empty space )  ஈ)        (vaccum) 

4 
என்௅ம என்று பார்க்கும் ல௅கயில் அ௅஫ந்துள்ர இ஭ண்டு ஆலணப் பக்கங்களின் ௃ொகுதி 

 )      (spread)        )         (folder)      )       (file)     ஈ)      (frame) 

5 
“““““““ ஋ன்பது Indesign-ல் உள்ர அ௅னத்து கருவிக௅ரயும் ௃காண்டுள்ர ௃பட்டி஬ாகும்.  

 )          (Tools panel)      )                   )           ஈ)      

6 
பக்கத்தின் இ஭ண்டு ௃நடுலரி௅சகளுக்கு இ௅ைப்பட்ை பகுதி  

 ) Gatter         )            )                ஈ)      (inter steller) 

7 

எரு பக்கத்தில் இைம்௃பரும் உ௅஭ப்பகுதி அல்யது உறுப்பு  

 )        (Graphics)     )       ( vector )   

 ) scalar   ஈ)                       

8 

““.. ஋ன்று Adobe Photoshop ௄பான்ம நி஭ல் மூயம் உருலாக்கப்படும் பைப்புள்ளிக௅ரக் (pixels) 

௃காண்ை நிறற்பைங்கள்  

 )       (bitmaps)      ) JPEG      ) PNG        ஈ)            

9 
இ஭ண்டு அல்யது மூன்று லண்ணங்கள் படிப்படி஬ாக இ௅ணத்து கய௅ல  

 ) Gradient       )          (colormix)       ) color platte       ஈ)        

10 
நிறுலனங்கரால் ெ஬ாரிக்கப்படும் ௃ச஬யற்ம  

 ) Spot       (Spot Colours)    )            )              ஈ)          

11 
எரு ௃பாருளின் உள்௄ர இைப்படும் லண்ணம்  

 )      (fill)      )      (stroke)     ) paint    ஈ) In- color 

12 
௃பாருளின் ௃லளிப்புமக் ௄காட்டில் இைப்படும் லண்ணம்  

 )      (stroke)      )       (fill)     ) out – color     ஈ) paint 

13 

View கட்ை௅ரக௅ர அென் ப஬ன்பாட்டுைன் ௃பாருத்துக 

Zoom in   )        100%               

Zoom out   )                                            

Actual size   )                               

Fit page in window  
ஈ)                                          

          

Fit spread in window  
 )            ,                          

      . 

1)      2) ஈ   3)      4)     5)   
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பகுதி - ஆ 

II மூன்று லரிகளில் வி௅ை஬ளிக்கவும். 

1 

Adobe in Design ஋ன்ன ௃஫ன்௃பாருள்?  

Adobe InDesign CC 2019 ஋ன்பது ‘Adobe Creative Clud’ குடும்பத்தின் ௃஫ன்௃பாருள் நி஭லின் எரு 

பகுதி஬ாகும். InDesign ஋ன்பது பக்க லடிலஅ௅஫வு ௃஫ன்௃பாருள் நி஭யாகும். இது 

லடில௅஫ப்பிற்கும் ஫ற்றும் ல௅யயில் அச்சிடுலெற்கு அல்யது ப஬ன்படுத்துலெற்கான 

ஆலணங்க௅ர உருலாக்குலெற்கும் ப஬ன்படுகிமது. ஋ளி஬ லணிக அட்௅ை முெல் ௃பரி஬ புத்ெகம் 

ல௅஭ ஋௅ெ ௄லண்டு஫ானாலும் உருலாக்கயாம். 

2 
஋த்ெ௅ன ல௅க஬ான ௃காைநி௅ய பக்க அ௅஫வுகள் உள்ரன? அ௅ல ஋௅ல?  

Orientation : ஆலணத்திற்கான பக்க லடில௅஫ப்பு 2. அ௅ல Landscape or Portrait 

3 

Adobe in Design ல் பணிப்பகுதி ஋ன்மால் ஋ன்ன?  

InDesign- ௅ன ௃ொைங்கி஬ பிமகு, தி௅஭஬கத்தில் காணப்படும் சன்னல் தி௅஭கள் ஫ற்றும் 

ெட்டுக்களின் அ௅஫ப்பு பணித்ெரம் (workspace) ஋னப்படும். 

4 

In Design ஆலண சன்னல் தி௅஭யில் ஋து அலசி஬஫ானது?  

முெல் மு௅ம஬ாக InDesign-஍ ௃ொைங்கும் ௄பாது ொன௅஫லாக இைம்௃பறும் பணித்ெரம் 

‚Essentials‛ ஋னப்படும். இது ௄஫௄ய கட்டுப்பாட்டுப் பயகம், இைப்புமம் கருவிப்பயகம் 

ஆகி஬லற்றுைன் InDesign சன்னல் தி௅஭யில் ௄ொன்றும்.தி௅஭யில் ௄ொன்றும் சன்னல்கள் ஫ற்றும் 

பயகங்கள் ஆகி஬லற்றின் அ௅஫ப்௄ப பணித்ெரம் ஋னப்படும். InDesign பணித்ெரம் பின்லரும் 

பகுதிக௅ர சிமப்பம்ச஫ாகக் ௃காண்டுள்ரது. ஆலண சன்னல் (Document Window), எட்டு பய௅க 

(Paste Board), கட்டுப்பாட்டுப் பயகம் (Control Panel), கருவிப் பயகம் (Tools panel) 

5 

In Design-ல் pasteboard ஋ன்பது ஋ன்ன?  

எட்டுப்பய௅க (Pasteboard) ஋ன்பது ஆலணச் சன்ன௅யச் சுற்றியுள்ர சாம்பல் நிமப்பகுதி ஆகும். 

எரு பக்கத்தில் அலற்௅மச் ௃சருகுலெற்கு முன்பு எட்டுப்பய௅கயில் உருப்படிக௅ர ௅லக்கயாம். 

நாம் ௄ச௅ய ௃சய்து ௃காண்டிருக்கும் உறுப்புகளின் ெற்காலிக ௄சமிப்பிற்காக எட்டுப்பய௅கயின் 

பகுதிக௅ரப் ப஬ன்படுத்ெயாம். அந்ெ பக்கத்திலிருந்து உறுப்புக௅ரக் கிளிக் ௃சய்து இழுத்து விை 

௄லண்டும் ஫ற்றும் ந஫க்கு ௄ெ௅லலப்படும் ல௅஭ அ௅ல எட்டுப்பய௅கயில் ெங்கி இருக்கும். 

6 

Tool tip ஋ப்௄பாது ௄ொன்றும்? 

கருவிப்பயகத்தில் கிளிக் ௃சய்஬ா஫ல் ஌௄ெனும் எரு கருவியின் மீது ௃சருகும் புள்ளி௅஬ ௅லக்கும் 

௃பாழுது tool tip ௄ொன்றும். இென் ௃ப஬ர் ஫ற்றும் குறுக்கு லழி சாவி அ௅ைப்புக்குறிக்குள் காட்டும். 

7 

Paste tool – ன் ப஬ன் ஋ன்ன? 

எரு ஆலணத்தின் உள்௄ர பல்௄லறு பக்க அரவுக௅ர உருலாக்க பக்கக்கருவி ப஬ன்படுகிமது. 

Shift + P ௅஬ பக்க கருவி௅஬த் ௄ெர்ந்௃ெடுக்க கிளிக் ௃சய்஬வும். இப்௃பாழுது கட்டுப்பாட்டுப் 

பக்கத்தில் (Control Page) உள்ர ௄ெர்௅லப் ப஬ன்படுத்தி பக்க அ௅஫௅ல ஫ாற்மவும். 

8 

Zoomins ஋ன்பது ஋ன்ன? 

InDesign-ல் உள்ர சிய பணிகளுக்கு, எரு ௃பாரு௅ர அல்யது ௃பாருளின் எரு பகுதி௅஬ உ஬ர் 

உருப்௃பருக்கம் அல்யது ௃பரிொக்குெல் மூயம் பார்௅லயிடுெல் ௄ெ௅லப்படுகிமது. எரு 

ஆலணத்தில் உள்ர எரு ௃பாரு௅ர ௃பரிொக்கி (Zoom in) உற்று ௄நாக்க ௃பரிொக்குெல் 

அனு஫திக்கிமது. அந்ெப் ௃பாரு௅ர (Zoom Out) சிறி஬ொக்கி வியகிச் ௃சன்று பார்க்க சிறிொக்குெல் 

ப஬ன்படுகிமது. ஆலணத்தில் உள்ர அ௅னத்௅ெயும் எ௄஭ ௄ந஭த்தில் காண இது பா஬ன்படுகிமது. 

ஆலணங்க௅ரப் பார்௅லயிை 5% முெல் 4000% ல௅஭ உருப்௃பருக்கயாம் அல்யது 

கு௅மக்கயாம். 
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9 

Tools panel-஍ திமக்க மூை உள்ர படிநி௅யக௅ர ஋ழுதுக. 

• Window → Tools ஍த் ௄ொோ்ந்௃ெடுக்க கருவிப் பயகத்௅ெ மூையாம். இ௅ெ மீண்டும் திமக்க 

Window → Tools ஍ ஫றுபடியும் ௄ொோ்ந்௃ெடுக்கவும். அல்யது 

• Tab சாவி௅஬ அழுத்தி கருவிப்பயகத்தில் உள்ர அ௅னத்து திமந்ெ பயகங்க௅ரயும் மூையாம். 

அந்ெ பயகங்க௅ர மீண்டும் திமக்க Tab சாவி௅஬ மீண்டும் அழுத்ெவும். மிெ௅ல கருவிப் 

பயகத்ெ௅ெ மூடுலெற்கு Close ௃பட்டி௅஬யும் கிளிக் ௃சய்஬யாம். 

10 

பந்தியில் ஋ண் லரி௅ச ஫ற்றும் புல்யட் குறியீடு உருலாக்க உெவும் படிநி௅ய௅஬ ஋ழுதுக. 

எரு பத்திக்கு புல்யட்கள் அல்யது ஋ண்க௅ரச் ௄சர்த்ெல் 

1. புல்யட் அல்யது ஋ண்கள் ௄சர்க்க விரும்பும் பத்தி௅஬த் ௄ொோ்ந்௃ெடுக்கவும். 

2. Type → Bulleted & Numbered Lists ஍த் ௄ெர்ந்௃ெடுக்கவும், பிமகு Apply Bullets அல்யெ Apply 

Numbers ஍ கிளிக் ௃சய்஬வும். 

பகுதி இ 

III எரு பத்தி஬ரவில் வி௅ை஬ளிக்கவும். 

1 

கருவி பயகத்௅ெ (Tools Panel) பற்றி விரிலாக விரக்கவும். 

கருவிப்பயகம், ௄ெர்ந்௃ெடுப்புக் கருவிகள் (Selection tools), அடிப்ப௅ை லடிலங்க௅ர 

ல௅஭லெற்கான கருவிகள், ல௅஭ெல் ஫ற்றும் புதுப்பித்ெல் கருவிகள் (Drawing and Editing) 

பரி஫ாற்மல் கருவிகள் (Transformation tools) உ௅஭ பதிப்பித்ெல் கருவிகள் (text editing tools) 

ந  ெல் கருவிகள் (Navifation tools) ௃பாருள் லடில௅஫ப்புக் கருவிகள் (Object formatting tools) 

௄பான்மலற்௅மக் ௃காண்டுள்ரது. ொன௅஫லாக கருவிப்பயகம், கட்டுப்பாட்டுப் பயகத்திற்கு கீ௄ற 

உள்ரது. ஆலண சன்னலின் இைது புமம் உள்ர கருவிப் பயகத்தில் அ௅னத்ெ கருவிகளும் 

உள்ரது. 

2 

கருவி பயகத்தில் (Tools panel) உள்ர ஌௄ெனும் 3 கருவிக௅ர பற்றி ஋ழுதுக. 

• ௄ெர்ந்௃ெடுப்புக் கருவி (Selection Tool (V Escape)) 

இது ௃பாருள்க௅ர அல்யது ௃பாருள்களின் ௃ொகுதி௅஬ ௄ெர்ந்௃ெடுக்கப் ப஬ன்படுகிமது. V 

஋ன்ம ௃பாத்ொ௅ன அழுத்தி இந்ெக் கருவி௅஬ ௄ொோ்ந்௃ெடுக்கயாம். 

• ௄ந஭டி    வு கருவி (Direct Selection tool (A)) 

இது எரு குழுவில் இருந்து எ௄஭ எரு ௃பாரு௅ர ௄ொோ்ந்௃ெடுக்க (A ௅ல அழுத்ெவும்) 

உெவுகிமது. 

• பக்கக் கருவி (page tool) 

எரு ஆலணத்தின் உள்௄ர பல்௄லறு பக்க அரவுக௅ர உருலாக்க பக்கக்கருவி 

ப஬ன்படுகிமது. 

3 

In Design-ல் உள்ர View கட்ை௅ரகள் ஬ா௅ல? 

View பட்டியில் உள்ர Zoom  கட்ை௅ரகள் Zoom in, Zoom out, Actual Size, Fit page in window, Fit 

Spread in window ஫ற்றும் Entire Pasteboard 

4 

௃பரிொக்குெலுைன் (Zooming) ௃ொைாோ்பு௅ை஬ சார்புகளுக்கான அ௅னத்து வி௅சப்பய௅க 

குறுக்குலழிக௅ர பற்றி ஋ழுதுக. 

Ctrl + = அழுத்ெவும் - ௃பரிொக்குெல்  

Ctrl + - அழுத்ெவும் - சிறிொக்குெல்  

Ctrl + 1 பக்கத்௅ெ அென் சரி஬ான அரவில் காணுெல்  

Ctrl + 2 பக்கத்௅ெ 200% அரவில் காணுெல்  

Ctrl + 0 ஆலண சன்னலில் முழு பக்கத்௅ெயும் ௃பாருத்துெல்  

Alt + Ctrl + ஆலண சன்னலில் முழு ப஭ல௅யயும் ௃பாருத்துெல்  

Ctrl + Spacebar (or) Ctrl + Alt + Spacebar ெற்காலிக஫ாக Zoom  கருவி௅஬ அணுகுெல் (௃பரிொக்க 

அல்யது சிறிொக்க) 
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5 

஋ழுத்துக்க௅ர ௄஫௃யாட்டு ஫ற்றும் கீ௃றாட்டு ஋ன ஋வ்லாறு ஫ாற்றுலாய்? 

கட்டுபாட்டு ெட்டில் இருந்து உ௅஭௅஬ கீ௃றாட்டு (Subscript) ஫ற்றும் ௄஫௃யாட்ைாக (Superscript) 

஫ாற்ம 

1. கீ௃றாட்டு அல்யது ௄஫௃யாட்ைாக ஫ாற்மப்பை ௄லண்டி஬ ஋ழுத்௅ெ    ந்௃ெடுக்கவும். 

2. கட்டுபாட்டுத் ெட்டில் உள்ர ஌௄ெனும் எரு ௃பாத்ொ௅னக் கிளிக் ௃சய்஬வும். ௄஫௃யாட்டு (T2 ) 

கீ௃றாட்டு (T2 ). 

3. ௄ெர்வு ௃சய்஬ப்பட்ை ஋ழுத்து ௄ெ௅லப்படும்படி ஫ாறும். 

6 

எரு ௃பாரு௅ர ஋ப்படி உருலாக்குலாய் ஋ன விரிலாக விலரி. 

சிய ௄ந஭ங்களில், ந஫து பதிப்பிற்கு ௄ெ௅லப்படும் எ௄஭ ல௅க ௃பாருள் ஋ளி஬ லடிலங்கராகும். 

லடிலங்கள் ஆலணத்௅ெப் பார்பெற்கான ஆர்லத்௅ெச் ௄சர்க்கின்மன. இது உ௅஭க்கு பின்னணி 

஬ாவும் பணி஬ாற்றுகிமது.  லடிலங்க௅ர உருலாக்கும் கருவிகள் Rectangle, Ellipse ஫ற்றும் 

polygon ௄பான்ம கருவிக௅ரக் ௃காண்டுள்ரது. எரு லடில கருவி௅஬த் ௄ெர்ந்௃ெடுக்க, கருவிகள் 

பயகத்தில் Rectangle  கருவி (ெற்ப௃பாழுது ௄ெர்ந்௃ெடுத்ெ லடில கருவி) மீது கிளிக் ௃சய்து 

சுட்௃ைலி ௃பாத்ொ௅ன அழுத்தி பிடித்ெலா௄ம,  நாம் ப஬ன்படுத்ெ விரும்பும் லடில கருவி௅஬த் 

௄ெர்ந்௃ெடுக்கயாம்.  

லடில கருவி ௄ெர்ந்௃ெடுக்கப்பட்ை பின், ஆலணத்தில் அ௅ெ இழுப்பென் மூயம் ௅கமு௅ம஬ாக 

(manually) லடிலத்௅ெ உருலாக்கயாம். 

7 

கருவி பயகத்திலுள்ர ல஭பை சட்ைங்கள் ஋த்ெ௅ன? அ௅ல ஬ா௅ல? 

ல௅஭க௅ய சட்ைங்க௅ர ல௅஭லெற்கு கருவிகள் பயகம் மூன்று கருவிக௅ரக் ௃காண்டுள்ரது. 

Ellipse சட்ைகம் இந்ெ கருவி௅஬ப் ப஬ன்படுத்தி நீள்லட்ை (Oval) ஫ற்றும் லட்ை (Round) 

சட்ைங்க௅ர உருலாக்கயாம். 

Rectangle சட்ைகம் இந்ெ கருவி௅஬ப் ப஬ன்படுத்தி ௃சவ்லக ஫ற்றும் சது஭ சட்ைங்க௅ர 

உருலாக்கயாம். 

Polygon சட்ைகம் இந்ெ கருவி௅஬ப் ப஬ன்படுத்தி ச஫பக்க பய௄காண (equilateral polygon 

சட்ைங்க௅ர உருலாக்கயாம்.  

பகுதி ஈ 

IV எரு பக்க அரவில் வி௅ை஬ளிக்கவும். 

1 

InDesign-ல் புதி஬ ஆலணத்௅ெ உருலாக்குலெற்கான படிநி௅யக௅ர ஋ழுதுக. 

1. Start → All Programs → Adobe Indesign CC 2019 ஋ன்ப௅ெ    வு ௃சய்஬வும் (அல்யது) 

தி௅஭முகப்பில் உள்ர InDesign குறுக்கு லழி௅஬த்    வு ௃சய்஬வும். 

2. Welcome to InDesign ஋ன்ம சன்னல் தி௅஭ திமக்கப்படும். இப்௃பாழுது Create New 

௃பாத்ொ௅னக் கிளிக் ௃சய்஬வும். 

3. இப்௃பாழுது New Document window புதி஬ ஆலண சன்னல் திமக்கப்படும். புதி஬ ஆலணத்௅ெ 

உருலாக்கும் ௃பாழுது New Document  உ௅஭஬ாைல் ௃பட்டியில் பய    வுக௅ர 

௃பாருத்துலெற்கான லாய்ப்பு கி௅ைக்கும். புதி஬ ஆலணத்தில் அடிப்ப௅ை    வுக௅ர 

௃பாருத்துலெற்கு. 

• New Document உ௅஭஬ாைல் ௃பட்டியில் Category ெத்ெலில் உள்ர print, web அல்யது Mobile஍ 

   வு ௃சய்஬வும். 

பின்லரும்    வுக௅ர ஌ற்கன௄ல    வு ௃சய்஬ப்பட்ை ௃ொகுதியில் குறிப்பிைவும். 

Width and Hight:  ஆலணத்தின் அர௅ல குறிப்பிடுகிமது. 

Units: ஆலணத்௅ெ அரவிடுலெற்கான அய௅கக் குறிப்பிடுகிமது. 

Orientation: ஆலணத்திற்கான பக்க லடில௅஫ப்௅ப (Landscape or Portrait) குறிப்பிடுகிமது. 

Pages: ஆலணத்தில் உருலாக்கப்படும் பக்கங்களின் ஋ண்ணிக்௅க௅஬ குறிப்பிடுகிமது. 

Facing Pages: எரு பக்கத்௅ெ ஫ட்டு௄஫ உ௅ை஬ ஆலணத்௅ெ உருலாக்குலெற்கு 

஋டுத்துக்காட்ைாக விரம்ப஭ங்கள், சுல௃஭ாட்டிகள், அல்யது துண்டு பி஭சு஭ங்கள் ஆகி஬லற்றுக்கு 
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Facing Pages-஍ Turn Off ௃சய்஬ ௄லண்டும். புத்ெகங்கள் ஫ற்றும் இெழ்கள் ஆகி஬லற்றுக்கு 

Facing Pages ஍ Turn on ௃சய்஬ ௄லண்டும். ஌௃னனில், இ௅ல லயது, இைது அல்யது முன், 

பின் ஋ன இரு பக்கங்க௅ரயும் ௃காண்டிருக்கும். 

Start #:  ஋ந்ெ ஋ண்ணில் ஆலணம் ௃ொைங்குகிமது ஋ன்ப௅ெக் குறிப்பிடுகிமது. 

௄ொோ்ந்௃ெடுக்கப்பட்ை Facing Pages  உைன் இ஭ட்௅ைப் ப௅ை ஋ண்க௅ர (அொலது 2) 

஋ன்ப௅ெக் குறிப்பிட்ைால் ஆலணத்தின முெல் ப஭லல் இ஭ண்டு பக்க ப஭லலுைன் 

௃ொைங்குகிமது. 

Primary Text Frame: முென்௅஫ பக்கத்தில் (Mater Page) முக்கி஬ உ௅஭௅஬ச்    க்க (Primary 

text) இந்ெத்    ௅ல    ந்௃ெடுக்கவும். 

Colums: ஆலணத்தில்    க்கப்பை ௄லண்டி஬ ௃நடுலரி௅சகளின் (Column) 

஋ண்ணிக்௅க௅஬க் குறிப்பிை ப஬ன்படுகிமது. 

Column Gutter: ௃நடுலரி௅சகளுக்கு இ௅ை௄஬ உள்ர இ௅ை௃லளியின் அர௅லக் குறிப்பிை 

உெவுகிமது. 

Margins: ஆலணத்தின் எவ்௃லாரு பக்கத்திற்கும் எரு அர௅ல குறிப்பிை ப஬ன்படுகிமது. 

பல்௄லறு பக்கங்களுக்கு பல்௄லறு ஫திப்புக௅ரப் ப஬ன்படுத்துகிமது. Chain பணிக்குறி௅஬ 

கிளிக் ௃சய்லென் மூயம் அரவுக௅ர பிரிக்க முடியும். 

Bleed and Slug: ஆலணத்தின் எவ்௃லாரு பக்கத்தினுை௄ன Bleed and Sug இருப்பிைத்௅ெ 

குறிப்பிடுகிமது. Chain பணிக்குறி௅஬ கிளிக் ௃சய்லென் மூயம் அரவுக௅ர பிரிக்க முடியும். 

4. முன்௄ப இருத்ெப்பட்ை அ௅஫ப்புக௄ராடு ஆலணத்௅ெத் திமக்க Create ௃பாத்ொன்க௅ரக் 

கிளிக் ௃சய்஬வும். 

2 

சிறு குறிப்பு ஋ழுதுக. 

ப஬ன்பாட்டு பட்௅ை (Application bar),  ஆலண ெத்ெல் (Document Tab), கருவி பயகம் (Tools 

Pannel) 

ப஬ன்பாட்டு பட்௅ை (Application bar)  

இது பணித்ெரத்திற்கு ௄஫ல் உள்ரது. இதில் பய பட்டிகள் (menu) உள்ரன.  எரு பட்டி௅஬த் 

திமக்க, ப஬ன்பாட்டு பட்௅ையில் உள்ர பட்டியின் ௃ப஬௅஭க் கிளிக் ௃சய்஬வும்.  எவ்௃லாரு 

பட்டியும் பட்டில௅க௄஬ாடு ௃ொைர்பு௅ை஬ கட்ை௅ரக௅ரப் பட்டி஬லிடும் பட்டிப்௃ப஬ர்களின் 

லயதுப்புமத்தில் பணித்ெரமும் ஫ற்றும் View ௄ெர்வுகளும் உள்ரன. 

 

ஆலண ெத்ெல் (Document Tab)  

ஆலணத் ெத்ெல், கி௅ை ஫ட்ை ரூயருக்கு ௄஫ல்பகுதியில் உள்ரது. இது ஆலணத்தின் ௃ப஬ர், 

உருப்௃பருக்கத்தின் நி௅ய (Magnification) ஫ற்றும் மூடு ௃பாத்ொன் ஆகி஬லற்௅மக் 

௃காண்டுள்ரது. என்றிற்கு ௄஫ற்பட்ை ஆலணங்கள் திமந்திருந்ொல், எவ்௃லாரு ஆலணத்திற்கும் 

எரு ெத்ெல் ௄ொன்றும் ஫ற்றும் ஆலணத் ெத்ெல்கள் கி௅ை஫ட்ை லரி௅சயில் ௄ொன்றும்.ஆலணத் 

ெத்ெ௅ய கிளிக் ௃சய்து, அந்ெ ஆலணத்௅ெச் சன்னல் தி௅஭யில் காணயாம். முழு௅஫஬ான 

சன்னல் தி௅஭யில் ஆலணத்௅ெத் திமக்க, ஆலணத் ெத்ெ௅ய கிளிக் ௃சய்து இழுத்து குழு௅ல 

விட்டு ௃லளி௄஬ற்ம ௄லண்டும். 

 

கருவி பயகம் (Tools Panel) 

InDesign-ல் இருக்கும் அ௅னத்து கருவிகளும் இந்ெ கருவிகள் பயகத்தில் இருக்கின்மன.  

௃பாரு௅ர உருலாக்கும் கருவிகள் (Rectangle  கருவி) ௃பாரு௅ர உரு஫ாற்றும் (Transforming) 

கருவிகள் (Rotate  கருவி), பக்க காட்சி௅஬ ஫ாற்றுெல் ஫ற்றும் பணித்ெரத்திற்கு ௃சல்லுெல் 

கருவிகள் (Zoom  கருவி ஫ற்றும் Hand கருவி ) ஆகி஬ கருவிகள் உள்ரன.  சிய கருவிகளின் கீழ் 

லயது மூ௅யயில் எரு சிறி஬ முக்௄காணம் இருக்கும்.  ௄஫லும் கூடுெயான கருவிகள் அந்ெ 

கருவியின் கீழ் உள்ரன. ஋ன்ப௅ெ இந்ெ முக்௄காணம் குறிக்கும். கிளிக் ௃சய்து அழுத்தி 

பிடிப்பென் மூயம் ஫௅மந்திருக்கும் கருவிக௅ரக் காணயாம். 

www.Padasalai.Net                                                                   www.CBSEtips.in

Kindly send me your study materials to our email id - padasalai.net@gmail.com

Pa
da

sa
la

i.N
et

Pa
da

sa
la

i.N
et

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://www.padasalai.net/
https://www.padasalai.net/


 
 

 13 M.Sc.,M.Ed.,M.Phil.,  

 

3 

பா௅ெயில் எரு ல௅கயி௅ன உருலாக்க படிநி௅யக௅ர ஋ழுதுக. 

எரு பா௅ெக் கருவியில் ெட்ைச்சு ௃சய்லென் மூயம், எரு பா௅ெயின் உள் அல்யது ௃லளிப்பும 

விளிம்பில் ெட்ைச்சு ௄சர்க்கயாம். பா௅ெயின் ஌கெனும் எரு பக்கத்தில் உ௅஭௅஬ச் ௄சசர்க்கயாம். 

ஆனால் இ஭ண்டு பக்கங்களிலும் ௄சர்க்க முடி஬ாது. முெலில் உ௅஭௅஬ உள் பக்க பா௅ெயில் 

௄சர்த்திருந்ொல் அ௅ெ பிமகு ௃லளிப்பக்க஫ாக நகர்த்திக் ௃காள்ரயாம். எரு பா௅ெயில் 

உ௅஭௅஬த் ௄ெர்ந்௃ெடுக்கும்௄பாது, அ௅ைப்புக் குறிக்குள் ௄ொன்றும். அென் நி௅ய௅஬ச் 

சரி௃சய்து உ௅஭௅஬ச் சரி௃சய்஬யாம்.  

பா௅ெயில் ெட்ைச்சு உருலாக்குெல்  

1. கருவிப் பயகத்தில் பா௅ெக்கருவியில் உள்ர ெட்ைச்௅ச ௄ெர்வு ௃சய்஬வும்.  

2. ெட்ைச்௅ச ௄சர்க்க பா௅ெயின் விளிம்பில் கிளிக் ௃சய்஬வும். (திமந்து அல்யது மூடி) உ௅஭ச் 

சட்ைகத்தில் எரு எளிரும் ௃சருகும் புள்ளி ௄ொன்றும்.  ௃பாருளில் உள்ர ஋ல்௅ய நீக்கப்படும்.  

3. ஌௄ெனும் உ௅஭௅஬த் ெட்ைச்சு ௃சய்஬வும். உ௅஭ ொனாக௄ல ஫டிந்து உ௅஭ச்சட்ைகத்திற்கு 

஌ற்மலாறு அ௅஫யும். ‘Enter’ ௃பாத்ொ௅ன அழுத்ெ ௄லண்டி஬தில்௅ய.  

4. ௃பாருளின் விளிம்பில் ெட்ைச்சு ௄ொன்றும். ஋ல்௅யக௅ர நீக்கிவிட்டு அென் லடிலத்தில் 

உறுதி஬ாக அ௅஫கிமது.  

5. Overflow குறியீடு ௄ொன்றினால் உ௅஭ச்சட்ைகத்தின் ௄ொோ்௅ல நீக்கி, ௄ெர்வுக் கருவி௅஬ 

கருவிப்பயகத்தில் இருந்து ௄ெர்வு ௃சய்து உ௅஭ச்சட்ைகத்தில் எரு மூ௅யயில் இழுக்கவும்.  

6. ௄ெர்வுக்கருவி௅஬ ௄ெர்வு ௃சய்஬வும் அல்யது ெட்ைச்சு கருவி௅஬ மீண்டும் ௄ெர்வு ௃சய்஬வும். 

4 

ஆலணத்தில் உ௅஭யி௅ன ௅லக்க படிநி௅யக௅ர ஋ழுதுக. 

1. பட்டிப்பட்௅ையில் இருந்து File →Place  ஍ ௄ெர்வு ௃சய்க.  

2. Place உ௅ர஬ாைல் ௃பட்டி ௄ொன்றும்.  

3. இருத்ெப்பை ௄லண்டி஬ உ௅஭க்௄காப்௅ப ௄ெர்வு ௃சய்து place உ௅஭஬ாைல் ௃பட்டியின் லயது 

பக்கத்தில் உள்ர Open  ௃பாத்ொ௅ன கிளிக் ௃சய்஬வும்.  

4. ௃சருகும் புள்ளி ௃சறிவூட்ைப்பட்ை உ௅஭ ௃சருகும் புள்ளி஬ாக ஫ாறுகிமது. இது ஆலணத்தில் 

உ௅஭ ௃சருகுலெற்கு ெ஬ா஭ாக உள்ரது ஋ன்ப௅ெ ௃ெரிவிக்கிமது.  

5. உ௅஭௅஬ இருத்துலெற்கு கிளிக் ௃சய்஬வும் (அ௄ெ பக்கத்தில் ௃சருகுலெற்கு) அல்யது புதி஬ 

உ௅஭ச்சட்ைகத்௅ெ உருலாக்குலெற்கு கிளிக் ௃சய்து இழுக்கவும்.  

6. உ௅஭௅஬ உ௅஭ச்சட்ைகத்தில் இருத்ெ முடி஬வில்௅ய ஋னில், எரு சிலப்பு + குறி஬ானது, 

உ௅஭ச்சட்ைகத்தின் கீழ் லயது ஋ல்௅யயில் Overflow குறியீைாக ௄ொன்றும்.  

7. இந்ெ Overflow குறியீட்௅ை கிளிக் ௃சய்ொல் மீெமுள்ர உ௅஭ ௃சருகும் புள்ளியில், கூடுெல் 

உ௅஭ச்சட்ைகத்தில் உ௅஭௅஬ச் ௄சர்ப்பெற்காக ஌ற்மப்படுகிமது.  உ௅஭஬ானது கிளிக் ௃சய்யும் 

௃பாழுது இருத்ெப்படும். கிளிக் ௃சய்து இழுத்ொல் புதி஬ உ௅஭ச்சட்ைகம் கூடுெல் உ௅஭யுைன் 

உருலாக்கப்படும்.  புதி஬ உ௅஭ச்சட்ைகம் முன்னர் உள்ர உ௅஭ச்சட்ைகத்துைன் 

இ௅ணக்கப்படும். இவ்லாறு இ௅ணக்கப்படும்௄பாது உ௅஭சட்ைகத்தின் அரவு அல்யது 

உ௅஭யின் லடிவூட்ைல் உ௅஭஬ானது இ஭ண்டு சட்ைகங்களுக்கு ஫ாற்மப்பட்ைால் இ௅ை௄஬ 

஋ளிொக நகர்கிமது. 

5 

ல௅஭க௅ய சட்ைத்தில் ஋வ்லாறு பைத்௅ெ    ப்பாய் படிநி௅யக௅ர ஋ழுதுக. 

ல௅஭க௅ய சட்ைகம் பிம ௃஫ன்௃பாருள் நி஭லில் உள்ர பைங்க௅ரத் ெருவிக்க ப஬ன்படுகிமது.  

சட்ைகத்தில் பைங்க௅ரச் ௃சருகயாம்.  

1. ல௅஭க௅ய சட்ைகத்௅ெ உருலாக்கு 

2. File →Place ஋ன்ப௅ெத் ௄ெர்ந்௃ெடுக்கவும். Place உ௅஭஬ாைல் ௃பட்டி ௄ொன்றும்.  

3. சட்ைகத்தில் ௃சருக விரும்பும் பைத்௅ெக் கண்டுபிடித்து ௄ெர்ந்௃ெடுக்கவும்.  

4. Open மீது கிளிக் ௃சய்஬வும். 
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பகுதி – அ 

I சரி஬ான வி௅ை௅஬த்    ந்௃ெடுத்து ஋ழுதுக. 

1 
_________ ஋ன்பது எரு ௃லக்ைர் ல௅஭க௅ய ப஬ன்பாைாகும்.   

 ) Pagemaker      ) photoshop      ) Corel Draw     ஈ) Ms Word 

2 

௃லக்ைார் ல௅஭க௅ய஬ானது _________ ௃காண்டு உருலாக்கப்படுகின்மது,  

 )                       )             

 )           ஈ)             

3 
_________ ஋ன்ப௅ல ௃சவ்லகப்பைம் (raster image) ஋ன அ௅றக்கப்படுகின்மன.  

 )                   )           )           ஈ)            

4 
_________ ௅ன ப஬ன்படுத்தி நீங்கள் ௃லக்ைார் ல௅஭க௅யயி௅ன உருலாக்க முடியும்.    

 ) Page Maker          ) Potoshop        ) Corel Draw         ஈ) MS-Word 

5 
௃சந்ெ஭ கருவிப்பட்௅ைக்கு (Stadard toolbar) அடுத்திருப்பது _________   

 )                )                 )              ஈ)            

6 
஋ந்ெ கருவி எரு ௃பாருளி௅ன ௄ெர்வு ௃சய்஬ உெவுகின்மது?   

 ) shape         ) zoom          ) Pick         ஈ) Crop     

7 
லட்ைத்௅ெ ல௅஭஬ அந்ெ கருவி உெவுகின்மது.  

 ) Shape         ) Ellipse           ) Rectangle        ஈ) Crop     

8 
஋த்ெ௅ன ல௅க சுருள்கள் உள்ரன?  

 ) 5      ) 3     ) 2      ஈ) 7 

9 
_________ சாவி஬ானது Freehand கருவியி௅ன ௄ெர்வு ௃சய்஬ உெவுகின்மது.  

 ) F2        ) F3       ) F4     ஈ) F5 

10 
Corel Draw-வில் எரு ஆலணத்௅ெ மூை _________ ௅ன அழுத்ெ ௄லண்டும்.  

 ) Ctrl + F4        ) Ctrl + F3       ) Shift + F4      ஈ) Alt + F4 

11 
Corel Draw விட்டு ௃லளி௄஬ம  

 ) Ctrl + F4        ) Ctrl + F3       ) Shift + F4      ஈ) Alt + F4 

12 
_________ சாவி எரு ௃பாரு௅ர ௄ெர்வு ௃சய்ெ௅ெ நீக்க உெவுகின்மது.  

 ) ESC         ) Ctrl      ) Shift     ஈ) Delete 

13 

_________ சாவி    ஫ானம் ௄ெர்வு ௃சய்஬ப்பட்ை ௃பாருளின் பி஭தியி௅ன உருலாக்க 

உெவுகின்மது. 

 ) Ctrl +D      ) Ctrl + C      ) Ctrl + S      ஈ) Ctrl + A 

14 
இ௅ணக்கப்பட்ை ௃பாருளி௅ன ெனித்ெனி௄஬ பிரிக்க _________௅ன அழுத்ெவும். 

 ) Ctrl + K           ) Ctrl + C         ) Ctrl + S       ஈ) Ctrl + A 

15 
இ஭ண்டு அல்யது அெற்கு ௄஫ற்பட்ை ௃பாருட்க௅ர இ௅ணக்க _______௅ன அழுத்ெவும்.    

 ) Ctrl + D        ) Ctrl + L     ) Ctrl + S      ஈ) Ctrl + A 

பகுதி - ஆ 

II மூன்று லரிகளில் வி௅ை஬ளிக்கவும். 

1 

Corel Draw ஋ெற்காக ப஬ன்படுத்ெப்படுகின்மது?  

CorelDraw ஋ன்பது உ஬ர்ெ஭ ல௅஭க௅ய சித்தி஭ங்கள், ௄யா௄கா லடில௅஫ப்பு ஫ற்றும் பக்க 

அ௅஫ப்புக௅ர உருலாக்குலெற்கான பல்து௅ம ல௅஭க௅ய ப஬ன்பாடு ஆகும். 
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Corel Drawவில் எரு புதி஬ ஆலணத்௅ெ உருலாக்க படிநி௅யக௅ர ஋ழுதுக.  

எரு புதி஬ ஆலணத்௅ெ உருலாக்க  

1. ல஭௄லற்பு தி௅஭யில் New Document ௃பாத்ொ௅ன கிளிக் ௃சய்஬வும்.  

2. இப்௄பாது Create a New Document உ௅஭஬ாைல் ௃பட்டி ௄ொன்றும். இது ஆலணத்தின் பய 

பண்புக௅ர உள்ளிை அனு஫திக்கிமது.  

3. நீங்கள் அதில் ஆலணத்திற்கு ௃ப஬ரிைவும், பக்க அரவு அ௅஫க்கவும், CMYK அல்யது RGB 

௄பான்ம நிம மு௅ம௅஫௅஬த் ௄ெர்வு ௃சய்஬வும், லண்ண நி஭ங்க௅ரயும் அ௅஫க்கயாம்.  

4. OK ௃பாத்ொ௅ன கிளிக் ௃சய்஬வும் 

3 

Corel Draw-வில் ைாக்கர் (Docker) ஋ன்மால் ஋ன்ன? 

ைாக்கர் (Docker) ஋ன்பது குறிப்பிட்ை கருவி அல்யது பணிக்கான கட்ை௅ரகள் ஫ற்றும் 

அ௅஫ப்புக௅ர ௃காண்ை எரு சன்னல் தி௅஭ அல்யது சார஭ம் ஆகும். 

4 

Corel Draw வி௅னத் ௃ொைங்குலெற்கான படிநி௅யக௅ர ஋ழுதுக.  

நாம் CorelDRAW 2018 ௄ந஭டி஬ாக ந஫து கணினியின் தி௅஭முகப்பில்  (Desktop) இருந்௄ொ 

அல்யது Windows  ௃ொைக்க பட்டியில் (Start Menu) இருந்௄ொ ௃ொைங்கயாம்.  

1. Start → All Programs → CorelDRAW Graphics Suite 2018 → CorelDRAW2018 

஋ன்ப௅ெ    ந்௃ெடுக்கவும் (அல்யது)  

2. தி௅஭முகப்பில், CorelDRAW 2018 குறுக்குவி௅ச குறும்பைத்௅ெ கண்ைறி஬வும். இது எரு 

லண்ண஫஬஫ான பலூன் லடில குறும்பைம்.  அென் கீழ் CorelDRAW2018  ஋ன்று 

குறிப்பிைப்பட்டிருக்கும். அெ௅ன இ஭ட்௅ைக் கிளிக் ௃சய்து திமக்கயாம். 

5 

Corel Draw வில் எரு ௃பாருள் ஋ன்௃மால் ஋ன்ன?  

கருவிக௅ர (tools) ௃காண்டு நாம் உருலாக்கும் ல௅஭பைங்கள் ௃பாருட்கள் ஋னப்படும். ௃பாருள் 

஋ன்பது பைம், லடிலம், ௄காடு, உ௅஭, ல௅ரவு, சின்னம், அல்யது அடுக்கு ௄பான்ம ல௅஭பைத்தின் 

எரு உறுப்பு. 

6 

Corel Draw வில் பண்பு பட்௅ை (Property Bar) ஋ன்௃மால் ஋ன்ன?  

பண்புப்பட்௅ை (Property bar) ௃சந்ெ஭ கருவிப்பட்டிக்கு அடுத்து இருக்கும். இ஬க்க கருவிக்கு 

௃ொைர்பு௅ை஬ ௃பாதுலான ௃ச஬ல்பாடுக௅ர இது காட்டுகிமது. இது கருவிப்பட்டி௅஬ப் ௄பாயத் 

௄ொன்றினாலும், கருவி அல்யது பணி௅஬ப் ௃பாருத்து பண்புகள் பட்௅ையின் உள்ரைக்கம் 

஫ாறுகிமது. 

7 

Corel Draw வில் ரூயர் (Ruler) ஌ன் ப஬ன்படுத்ெப்படுகின்மது.  

சார஭த்தில் இ஭ண்டு ரூயர் இருக்கும். அரல கி௅ை஫ட்ை ரூயர் ஫ற்றும் ௃சங்குத்து ரூயர். அ௅ல 

எரு ஆலணத்தில் ௃பாருட்களின் அரவு ஫ற்றும் நி௅ய௅஬ தீர்஫ானிக்க ப஬ன்படுத்ெப்படுகின்மன. 

8 

CorelDraw வில் க௅யத்திமனுள்ர ஊைக கருவி (Artistic Media tool) ஌ன் 

ப஬ன்படுத்ெப்படுகின்மது?  

க௅ய தூரி௅க, ௃ெளிப்பு ஫ற்றும் calligraphic வி௅ரவுக௅ர ௄சர்ப்பெற்கு ப஬ன்படுகிமது. 

9 

௃பாருட்க௅ர குழுலாக்க படிநி௅யக௅ர ஋ழுதுக.  

1. Pick கருவி ௃காண்டு ௃பாருள்க௅ர ௄ெர்வு ௃சய்஬வும். (பய ௃பாருள்க௅ர    வு ௃சய்஬ 

Shift சாவியி௅ன அழுத்தி஬லாறு ௄ெர்வு ௃சய்஬வும்.  

2. Object → Group → Group objects ஋ன்ப௅ெ ௄ெர்வு ௃சய்஬வும் (அல்யது) Ctrl + G ௅ன 

அழுத்ெவும். ௄ெர்வு ௃சய்஬ப்பட்ை ௃பாருட்கள் எ௄஭ ௃பாருராக குழுலாக்கப்படும். 

10 

குழுலாக்கப்பட்ை ௃பாருளின் குழுலாக்கத்௅ெ நீக்க படிநி௅யக௅ர ஋ழுதுக.  

1. Pick கருவி ௃காண்டு குழுலாக்கப்பட்ை ௃பாரு௅ர ௄ெர்வு ௃சய்஬வும். 

2. பட்டிபட்௅ையிலிருந்து Object → Group → Ungroup Objects ஋ன்ப௅ெ    வு ௃சய்஬வும் 

(அல்யது) வி௅சப்பய௅கயிலுள்ர Ctrl + U ஋ன்ப௅ெ அழுத்ெவும் அல்யது Property 

பட்௅ையிலுள்ர Ungroup objects  ஋ன்ப௅ெ கிளிக் ௃சய்஬வும். குழுலாக்கப்பட்ை ௃பாருரானது 

அெனு௅ை஬ ௃பாருட்களின் கூறுகராக பிரியும் 
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பகுதி இ 

III எரு பத்தி஬ரவில் வி௅ை஬ளிக்கவும். 

1 

௃லக்ைார் ல௅஭க௅யக்கும் பிட்௄஫ப்ஸ் (Bitmaps) கும் இ௅ை௄஬ உள்ர ௄லறுபாடுகள் ஬ா௅ல?  

௃லக்ைர் ல௅஭க௅ய஬ானது (Vector graphics) ௄காடுகள் ஫ற்றும் ல௅ரவுகள் ௃காண்டு 

உருலாக்கப்படுகின்மது.  இ௅லகள் கணிெத்திற்குரி஬ விரக்கங்க௅ர ௃காண்டு 

உருலாக்கப்படுகின்மன. இவ்ல௅க஬ான ல௅஭க௅ய஬ானது சின்னங்கள் ஫ற்றும் 

விரக்கப்பைங்கள் (Logos and illustrations) ஆகி஬லற்றிற்கு ஌ற்ம௅ல ஆகும்.  

பிட்௄஫ப்ஸ் (Bitmaps) ஋ன்பது ௃சவ்லகப்பைம் (Raster images) ஋ன அ௅றக்கப்படுகின்மது. இது 

பைபுள்ளிகள் (Pixels) ஋ன அ௅றக்கப்படும் சிறி஬ சது஭ங்க௅ர ௃காண்டு உருலாக்கப்படுகின்மது. 

2 

Corel Draw வில் எரு ௃சவ்லகத்௅ெ ல௅஭லற்கு படிநி௅யக௅ர ஋ழுதுக.  

1. எரு ௃சவ்லகத்௅ெ ல௅஭஬ கருவிப்பட்௅ையில் இருந்து Rectangle கருவி௅஬ 

௄ெர்ந்௃ெடுக்கவும். சுட்டி சிறு சது஭த்௅ெ ௃காண்ை crosshair சுட்டி஬ாக ஫ாறும்.  

2. ல௅஭ெல் பகுதியில் ஋ங்கு ௄லண்டு௄஫ா அங்கு கிளிக் ௃சய்து ௃காண்டு இழுக்கவும். நாம் 

சுட்டி௅஬ இழுக்க, எரு ௃சவ்லக ௄ொன்றும்.  

3. ௄ெ௅ல஬ான அரவுள்ர ௃சவ்லகம் ௄ொன்றி஬வுைன் சுட்டி ௃பாத்ொன் அழுத்துல௅ெ 

விட்டுவிை ௄லண்டும்.  

4. இப்௄பாது எரு ௃சவ்லகம் தி௅஭யில் ௄ொன்றும். 

3 

Corel Draw வில் லட்ைம் ல௅஭஬ படிநி௅யக௅ர ஋ழுதுக. 

1. லட்ைம் ல௅஭஬ நீள்லட்ை Ellipse கருவி௅஬ கருவிபட்௅ையிலிருந்து    ந்௃ெடுக்கவும். 

சுட்டியின் லடிலம் Crosshair குறியுைன் கீழ்ப்பகுதியில் நீள்லட்ைம் ௃காண்டு குறி஬ாக 

இருக்கும்.  

2. இப்௄பாது ல௅஭யும் பகுதியில் ஋ங்கு லட்ைம் ல௅஭஬ ௄லண்டும் அங்கு ctrl வி௅ச௅஬ 

அழுத்தி ௅லத்ெலாறு சுட்டியின் இைது ௃பாத்ொ௅ன இழுத்து நகர்த்ெ ௄லண்டும்.  

3. நீங்கள் விரும்பும் லட்ைலடிலம் ௄ொன்றி஬வுைன் சுட்டியின் ௃பாத்ொ௅ன அழுத்துல௅ெ 

விட்டுவிைவும். 

4 

இ஭ண்டு ல௅க஬ான சுருள்கள் ஋ன்ப௅ல ஋ன்ன? விரக்குக.  

இ஭ண்டு ல௅க஬ான சுருள் ல௅ககள் உள்ரன . 

1. ச஫சீர் சுருள் (Symmetrical spiral)  

2. ஫ைக்௅க சுருள் (Logarithmic spiral)  

ச஫சீர் சுருள் மு௅மயில் சுருள் ச஫ அரவில் விரில௅ையும். ஋ன௄ல எவ்௃லாரு சுறற்சியும் ச஫ 

அரவு௅ை஬ சுரு௅ர உருலாக்கும். ஫ைக்௅க சுருள் மு௅மயில் சுறற்சி உருலாக்கும் 

சுருள்களுக்கி௅ை௄஬஬ான தூ஭ம் அதிகரித்ெலா௄ம காணப்படும். நாம் spiral கருவி௅஬ 

௃காண்டு பய அரவுகளில் சுருள்க௅ர ல௅஭஬ முடியும்.  

5 

Flyout னு௅ை஬ ஋ந்ெ கருவி஬ானது நட்சத்தி஭ கருவியி௅ன ௃காண்டிருக்கும்?  

Flyout ன் Polygon tool நட்சத்தி஭ கருவி௅஬க் ௃காண்டிருக்கும். குறுக்குலழி 

சாவி Y ஆகும்  

Polygon tool (Y) - Polygon, Star, Complex Star, Impact tool, GraphPaper, Spiral, 

Basic Shapes, ArrowShapes, Flowchart Shapes, BannerShapes ஫ற்றும் Callout 

Shapes கருவிக௅ர அணுக உெவுகிமது. 

6 

Corel Draw வில் பி௅றக௅ர சரி ௃சய்஬ ஋ன்ன ௃சய்஬ ௄லண்டும்?  அெ௅ன ௃சய்லெற்௃கான 

வி௅சப்பய௅க குறுக்கு லழி ஋ன்ன?  

நைப்பு அ஫ர்வில் நாம் முன்னர் ௃சய்ெ ௃ச஬ல்பாடுக௅ர Corel Draw நி௅னவில் 

௃காண்டிருக்கும். மிக சமீபத்தில் நாம் ௃சய்ெ ௃ச஬லில் ஆ஭ம்பித்து, நாம் ல௅஭யும் ௃பாழுது ௃சய்ெ 

௃ச஬ல்க௅ர ஋ல்யாம் உங்கரால் Undo ௃சய்஬ முடியும். எரு ௃ச஬௅ய Undo (௃சய்ெ௅ெ நீக்கு) 
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௃சய்லதினால் லரும் வி௅ரவுகள் உங்களுக்கு பிடிக்கவில்௅ய ஋னில் நாம் அெ௅ன Redo 

(஫றுபடியும் ௃சய்) ௃சய்து ௃காள்ரயாம்.  

To Undo, Redo and Repeat ௃ச஬ல்கள்  

எரு ௃ச஬௅ய Undo ௃சய்஬  

Edit → Undo ௄ொோ்வு ௃சய்஬வும் (க௅ைசி ௃ச஬ல்) (Ctrl + Z.) 

எரு ௃ச஬௅ய Redo ௃சய்஬  

Edit → Redo ௄ொோ்வு ௃சய்஬வும் (Ctrl + Shift +Z.) 

ல௅஭பைத்தின் க௅ைசி஬ாக ௄சமிக்கப்பட்ை நி௅யக்கு பின்௃சல்ய  

File → Revert ௄ொோ்வு ௃சய்஬வும்.  

எரு ௃ச஬௅ய மீண்டும் மீண்டும் ௃சய்஬  

Edit → Repeat ௄ொோ்வு ௃சய்஬வும். 

7 

எரு ௄காட்டி௅ன அம்புகுறி஬ாக ஫ாற்றுலெற்கு நீங்கள் ஋ன்ன ௃சய்வீர்கள்?  

1. Freehand கருவி மூயம் எரு ௄காடு ல௅஭஬வும்.  

2. ௄காட்௅ை ௄ொோ்ந்௃ெடுக்கவும்.  

3. பண்புபட்௅ையில் உள்ர End Arrow head Selector  கீ௄ற இமங்கு பட்டி௃பட்டியில் கிளிக் 

௃சய்஬வும். 

4. பின் ௄ெ௅ல஬ான அம்புக்குறி மு௅ன௅஬ ௄ொோ்வு ௃சய்஬வும். இப்௄பாது ௄காடு 

அம்புக்குறியுைன் ௄ொன்றும். 

8 

எரு ௃பாருளுக்கு நி஭ப்பு லண்ணத்௅ெயும் ஫ற்றும் ஋ல்௅யக்௄காட்டின் லண்ணத்௅ெயும் 

஋வ்௃லாறு குறிப்பிடுலாய்?  

1. Pick கருவி௅஬ ப஬ன்படுத்தி ௃பாரு௅ரத் ௄ெர்ந்௃ெடுக்கவும்.  

2. லண்ணத்ெட்டில் ஌ொலது எரு லண்ணத்௅ெ கிளிக் ௃சய்஬வும்.  

3.    ந்௃ெடுக்கப்பட்ை ௃பாருளுக்கு லண்ணங்கள்    ந்திருக்கும்.  

4. லண்ணத்ெட்டில் உள்ர ஌ொலது எரு லண்ணத்தில் ௅லத்து லயது ௃பாத்ொ௅னக் கிளிக் 

௃சய்஬வும்.  

5. ௄ெர்ந்௃ெடுக்கப்பட்ை ௃பாருளின் லண்ணம்    ந்௃ெடுக்கப்பட்ை லண்ணத்திற்கு 

஫ாறியிருக்கும்.  

9 

௃பாருட்களின் பி஭தி ஫ற்றும் ௃பாருட்களின் நகலியி௅ன ஋வ்லாறு உருலாக்குலாய்? 

இ஭ண்டிற்கும் உள்ர ௄லறுபாட்௅ை ஋ழுெவும்.  

௄ெர்வு ௃சய்஬ப்பட்ை ௃பாரு௅ர நகல் ஋டுத்ெல்.  

பட்டி பட்௅ையிலிருந்து Edit → Dupilicate ஋ன்ப௅ெ    வு ௃சய்஬வும் அல்யது 

வி௅சப்பய௅கயில் Ctrl + D ஋ன்ப௅ெ அழுத்ெவும். நகயானது அசல் ௃பாருளின் ௄஫ற்பும 

லயது புமத்திலிருந்து சற்று நகர்ந்து கீழ்கண்ைலாறு ௄ொன்றும். புதி஬ நகயானது ொனாக௄ல 

   வு ௃சய்஬ப்பட்டு லரும்.  

௃பாருட்க௅ர நகலி ௃சய்ெல் (Cloning Obejects)  

௄ெர்வு ௃சய்஬ப்பட்ை ௃பாருளின் நகலி (Clone) ௅஬ உருலாக்க Edit → Clone ஋ன்ப௅ெ 

பட்டிபட்௅ையிலிருந்து    வு ௃சய்஬வும். நகலி஬ானது அசல் பாருளின் ௄஫ற்பும லயது 

புமத்திலிருந்து சற்று நகர்ந்து கீழ்கண்ைலாறு ௄ொன்றும். புதி஬ நகயானது ொனாக௄ல 

௄ொோ்வு ௃சய்஬ப்பட்டு விடும். நகலி ௃சய்ெல் பி஭தி ஋டுத்ெலிருந்து ௄லறுபட்ைொகும். அசல் 

௃பாருளின் மீது ௃சய்஬ப்படும் அ௅னத்து ஫ாற்மங்களும் நகலி மீதும் ொனாக௄ல 

௃ச஬ற்படுத்ெப்படும்.  

஋டுத்துக்காட்ைாக நாம் அசல் ௃பாருளின் நி஭ப்பி௅஬ (Fill) ஫ாற்றும் ௃பாழுது, நகலியினு௅ை஬ 

நி஭ப்பியும் ஫ாறும்.  
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10 

௃பாருள்க௅ர ௃லல்டிங் ௃சய்லென் மூயம் ஋ன்ன ௃பம முடியும்? ௃பாருள்க௅ர ௃லல்டிங் 

௃சய்லெற்கான படிநி௅யக௅ர ஋ழுதுக.  

௃லல்டிங் ௃சய்லென் மூயம் எழுங்கற்ம லடிலங்க௅ர நாம் உருலாக்க முடியும். ௃லல்டிங் 

௃சய்஬ப்பட்ை ௃பாருட்கள் க௅ைசி஬ாக ௄ெர்வு ௃சய்஬ப்பட்ை ௃பாருளின் ஋ல்௅ய ௄காட்டி௅னயும், 

நி஭ப்புெ௅யயும் ஋டுத்து ௃காள்ளும். ௃லல்டிங் ௃சய்஬ப்பட்ை ௃பாருட்க௅ர மீண்டும் ெனித்ெனி 

௃பாருட்கராக ஫ாற்றி஬௅஫க்க Undo ௃பாத்ொ௅ன ஫ட்டு௄஫ ப஬ன்படுத்ெ முடியும்.  

Property பட்௅ை ௃காண்டு ௃பாருள்க௅ர ௃லல்டிங் ௃சய்஬  

1. Pick கருவி ௃காண்டு (அல்யது) Shift சாவியி௅ன அழுத்தி஬லாறு ௃பாருள்க௅ர    வு 

௃சய்஬வும்.  

2. Object→Shaping→Weld ஋ன்ம கட்ை௅ரயி௅ன பட்டிபட்௅ையிலிருந்து    வு ௃சய்஬வும் 

(அல்யது) Property பட்௅ையிலுள்ர Weld ௃பாத்ொ௅ன கிளிக் ௃சய்஬வும்.  

3. ௃பாருள்கள் ௃லல்டிங் ௃சய்஬ப்பட்டு, எ௄஭ ஋ல்௅யக்௄காடு ௃காண்ை ௃பாருராக ஫ாறும். 

பகுதி – ஈ 

IV. எரு பக்க அரவில் வி௅ை஬ளிக்கவும்.  

1 

சுருளி௅ன (Spiral) ல௅஭஬ படிநி௅யக௅ர ஋ழுதுக.  

சுருள் ல௅஭஬  

1. பய௄காண கருவியின் மீது அழுத்திப் பிடித்ெலா௄஭ இருந்ொல் flyout பட்டி ௄ொன்றி ௄஫லும் 

பய கருவிக௅ர காட்டும்.  

2. flyout பட்டியில் உள்ர சுருள் (Sprial) கருவி௅஬ கிளிக் ௃சய்஬வும்.  

3. நாம் பண்பு பட்௅ையில் உள்ர சுருள் சுறற்சி ௃பட்டியில் ஋ண்ணிக்௅க௅஬ ௃காடுப்பென் 

மூயம் ௄ெ௅ல஬ான லட்ைம் உ௅ை஬ புதி஬ சுருள் அ௅஫ப்௅ப உருலாக்க முடியும்.  

4. பின் பண்புபட்௅ையில் கீழ்கண்ை ஌௄ெனும் எரு ௃பாத்ொ௅ன கிளிக் ௃சய்஬வும்.  

 ச஫சீர் சுருள் (Symmetrical spiral)  

 ஫ைக்௅க சுருள் (Logarithmic spiral)  

சுறற்சி௅஬ ௃லளிப்பும஫ாக நகர்த்தும் ௄பாது சுருள் விரிலாக்க அரவுக௅ர ஫ாற்ம 

விரும்பினால் spiral expansion slider ஍ நகர்த்ெவும்.  

ல௅஭யும் சன்னல் தி௅஭யில் ந஫க்கு ௄லண்டி஬ அரவு உள்ர சுருள் லரும் ல௅஭ சுட்டி௅஬ 

கி௅ை ஫ட்ை஫ாக இழுக்கவும்.  

2 

பய௄காணங்க௅ர (Polygon) ௅஬ படிநி௅யக௅ர ஋ழுதுக.  

1. பய௄காண உருலம் ல௅஭஬ (஍ங்௄காணம் - ஍ந்து பக்கம் உ௅ை஬ உருலம் ஋ன்றும் 

அறி஬ப்படுகிமது) polygon கருவி௅஬ கருவிபட்௅ையிலிருந்து    ந்௃ெடுக்கவும். சுட்டியின் 

லடிலம் Crosshair குறியுைன் கீழ்ப்பகுதியில் பய௄காணம் ௃காண்ை குறி஬ாக இருக்கும்.  

2. இப்௄பாது ல௅஭யும் பகுதியில் ஋ங்கு ஍ங்௄காணம் ல௅஭஬ ௄லண்டு௄஫ா அங்கு சுட்டியின் 

இைது ௃பாத்ொ௅ன அழுத்தி பிடித்ெலாறு நகர்த்ெ ௄லண்டும்.  

3. நாம் விரும்பும் லடிலமு௅ை஬ முக்௄காணம் உருலானவுைன் சுட்டியின் ௃பாத்ொ௅ன 

அழுத்துல௅ெ விட்டு விைவும்.  

4. ல௅ரந்ெ பய௄காணத்தின் பக்கங்க௅ர அதிகரிக்க நாம் ல௅ரந்ெ பய௄காணத்௅ெ pick 

கருவி மூயம்    ந்௃ெடுக்கவும்.  

5. சுட்டி௅஬ பண்புபட்௅ையில் உள்ர Number of Points on Polygon உ௅஭ப்௃பட்டியில் கிளிக் 

௃சய்து ௄ெ௅ல஬ான பக்கங்களின் ஋ண்ணிக்௅க௅஬ ௃காடுக்கவும்.  
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3 

Corel Draw வில் ஋வ்லாறு எரு நட்சத்தி஭த்௅ெ உருலாக்குலாய்?  

நட்சத்தி஭ம் ல௅஭ெல்  

polygon கருவியின் கீழ்ப்பகுதியில் சிறி஬ அம்புக்குறி உள்ரது. இந்ெ அம்புகுறி flyout உள்ர௅ெ 

உணர்த்துகிமது நட்சத்தி஭ம் ல௅஭஬  

1. பய௄காண கருவியின் மீது அழுத்திக்௃காண்௄ை இருந்ொல் flyout பட்டி ௄ொன்றி ௄஫லும் 

பய கருவிக௅ர காட்டும்.  

2. flyout பட்டியில் உள்ர நட்சத்தி஭க் கருவி௅஬ கிளிக் ௃சய்஬வும்.  

3. ல௅஭யும் பகுதியில் ஋ங்கு நட்சத்தி஭ம் ல௅஭஬௄லண்டு௄஫ா அங்கு சுட்டியின் இைது 

௃பாத்ொ௅ன அழுத்தி பிடித்ெலாறு இழுத்து நகர்த்ெவும். 

4. நட்சத்தி஭ உருலம் உருலானவுைன் சுட்டியின் ௃பாத்ொ௅ன அழுத்துல௅ெ விட்டு விைவும்.  

4 

கட்ைங்க௅ர (Grid) ல௅஭஬ படிநி௅யக௅ர ஋ழுதுக.  

கட்ைங்கள் ல௅஭ெல்  

Graph Paper கருவி௅஬ ப஬ன்படுத்தி நாம் குறிப்பிட்ை ஋ண்ணிக்௅க லரி௅ச ஫ற்றும் 

௃நடுலரி௅சக௅ர ௃காண்ை எரு கட்ைகம் ல௅஭஬யாம். கட்ைகம் ஋ன்பது ெனித்ெனி஬ாக 

பிரிக்கக்கூடி஬ பய ௃சவ்லகங்கள் ௄சர்ந்ெ அ௅஫ப்பாகும்.  

எரு கட்ைகம் ல௅஭஬  

1. பய௄காண கருவியின் மீது அழுத்திக் ௃காண்௄ை இருந்ொல் flyout பட்டி ௄ொன்றி ௄஫லும் 

பய கருவிக௅ர காட்டும்.  

2. flyout பட்டியில் உள்ர Graph Paper கருவி௅஬ கிளிக் ௃சய்஬வும்.  

3. பண்புபட்௅ையில் உள்ர ௄஫ல் ஫ற்றும் கீழ்ப்பகுதியில் ௃நடுலரி௅ச ஫ற்றும் லரி௅சகளின் 

஋ண்ணிக்௅க௅஬ உள்ளிைவும். ௃கல் பகுதியில் உள்ளிைப்படும் ஫திப்பு ௃நடுலரி௅ச 

஋ண்ணிக்௅க௅஬யும் கீழ்ப்பகுதியில் உள்ளிைப்படும் ஫திப்பு லரி௅ச ஋ண்ணிக்௅க௅஬யும் 

குறிக்கும். 

4. ல௅஭யும் பகுதியில் ஋ங்கு கட்ைகம் ௄ொன்ம ௄லண்டு௄஫ா அங்கு கிளிக் ௃சய்஬வும்.  

5. சுட்டி௅஬ கி௅ை஫ட்ை஫ாக இழுப்பென் மூயம் ௄லண்டி஬ கட்ைகம் ல௅஭஬ முடியும்.  

6. ௅஫஬ப் புள்ளியிலிருந்து ௃லளிப்பும஫ாக கட்ைங்கள் ல௅஭஬ shift  வி௅ச௅஬ 

அழுத்தி஬லாறு நகர்த்ெ   ண்டும்.  கட்ைங்க௅ர சது஭ லடிவில் அ௅஫க்க Ctrl வி௅ச௅஬ 

அழுத்தி஬லாறு நகர்த்ெ ௄லண்டும். 

5 

பா௅ெயில் உ௅஫யி௅ன ௃பாருத்துெல் பற்றி விரிலாக ஋ழுது.  

஋ந்ெ லடில பா௅ெயிலும் உ௅஭ ச஭த்௅ெ ௃பாருத்ெ Corel Draw அனு஫திக்கின்மது. அது ௄நர் 

அல்யது ல௅஭ந்ெ ௄காடு, எரு ௃சவ்லகம், எரு நீள்லட்ைம் அல்யது ஫ற்௃மாரு ஋ழுத்து அல்யது 

உ௅஭ ச஭ம் ஋ன பயலடில பா௅ெகராக இருக்கயாம். உ௅஭யி௅ன பா௅ெயில் 

௃பாருத்துலெற்கு Text பட்டியிலிருந்து Fit text to path கட்ை௅ரயி௅ன ப஬ன்படுத்ெவும்  

உ௅஭யி௅ன பா௅ெயில் ௃பாருத்துெல்  

1. Pick கருவி ஫ற்றும் Shift சாவி ௃காண்டு உ௅஭ ௃பாரு௅ரயும் ஫ற்றும் இ஭ண்ைாலது 

௃பாரு௅ரயும் ௄ெர்வு ௃சய்஬வும்.  

2. Text பட்டியிலிருந்து Fit + Text to path ஋ன்ப௅ெ ௄ெர்வு ௃சய்஬வும்.  

3. இ஭ண்ைாலது ௃பாருளின் பா௅ெயின் லழி உ௅஭஬ானது மீண்டும் ல௅஭஬ப்படுகின்மது. 
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பகுதி – அ 

I சரி஬ான வி௅ை௅஬த் ௄ெர்ந்௃ெடுத்து ஋ழுதுக 

1 

_________ ஋ன்ப௅ெ என்றிற்கு ௄஫ற்பட்ை ஊைக ல௅க஬ான உ௅஭, தி௅஭க௅ய, எளிக்காட்சி, 

அ௅சவூட்ைல் ஫ற்றும் எலி ஆகி஬லற்றில் ஌௄ெனும் எரு ல௅கப்ப஬ன்பாட்௅ைக் குறிக்கும்.   

 )                       )                 )             ஈ)      

2 
பல்லூைகத்தின் கு௅மபாடுகளில் என்று அெனு௅ை஬ _________   

 )          )                )               ஈ)         

3 

விரிலாக்கம் JPEG  

 ) Joint Photo exports gross         ) Joint Photographic experts group 

 ) Joint processor experts group   ஈ) Joint Photographic expression group 

4 
பல்லூைகத்௅ெ உருலாக்க ந஫க்கு ௄ெ௅ல஬ான௅ல லன்௃பாருள், ௃஫ன்௃பாருள் ஫ற்றும் ____   

 )              ) CD           )               ஈ)            

5 

சரி஬ான என்௅மத் ௄ெர்ந்௃ெடுத்து பின்லருலனலற்௅ம ௃பாருத்துக.  

1. உ௅஭ - TGA  

2. நிறற்பைம் - MIDI  

3. எலி - MPEG  

4. எளி - RTF  

 ) 1, 2, 3, 4        ) 2, 3, 4, 1          ) 4, 1, 2, 3          ஈ) 3, 4, 1, 2 

6 
பின்லருலனலற்றில் ௃பாருந்ொெ என்௅மக் கண்டுபிடிக்கவும். 

 ) TIFF          ) BMP       ) RTF         ஈ) JPEG 

7 
______ ஋ன்பது அ௅ச஬ா நிறற்பைங்க௅ர ௃ொைர்ச்சி஬ான இ஬க்க஫ாக காட்சிப்படுத்தும் ௃ச஬ல். 

 )                 )          ) MP3     ஈ)          

8 

இரண஬த்தின் மூயம் நிகழ்௄ந஭ நிகழ்ச்சிக௅ர ௄ந஭டி஬ாக எளிப்ப஭ப்புல௅ெ _________ 

஋ன்கி௄மாம்.  

 )                 )               

 )                ஈ)                

9 
GIF ப஬ன்படுத்தும் லண்ண ௄ெைல் அட்ைல௅ண _________  

 ) 8       ) 8KB      ) 8 MB       ஈ) 8GB 

10 
RTF ௄காப்பு லடிலத்௅ெ அறிமுகப்படுத்தி஬து _________  

 ) TCS          ) Micorsoft       ) Apple      ஈ) IBM 

பகுதி – ஆ 

II மூன்று லரிகளில் வி௅ை஬ளிக்கவும் 

1 

ல௅஭஬று – பல்லூைகம் ஫ற்றும் அென் சிமப்பம்சம்.  

பல்௄லறு லரங்கரான நிறற்பைம், உ௅஭, ல௅஭க௅ய, எளிக்காட்சி, எலி ஫ற்றும் எளி 

ஆகி஬லற்ரம என்றி௅ணத்து, ெ஭வுக௅ர எற்௅மத்ெரத்திற்கு ஫ாற்ம ப஬னர்களுக்கு 

பல்லூைகம் அனு஫தி அளிக்கிமது. 

2 

பல்லூைக கூறுக௅ரப் பட்டி஬லிடுக.  

பல்லூைகம் 5 முக்கி஬ கூறுக௅ரக் ௃காண்டுள்ரது. அ௅ல உ௅஭,  நிறற்பைம், எலி,  எளிக்காட்சி 

஫ற்றும் அ௅சவூட்ைல். 
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பல்லூைகத்தில் உ௅஭ (Text) கூறி௅ன ல௅கப்படுத்துக.  

நி௅ய஬ான உ௅஭ (Static text)  : எரு ெ௅யப்பி௄ரா அல்யது எரு லரியி௄யா அல்யது எரு 

பத்தியி௄யா, உ௅஭ அல்யது ௃சால் ஫ாமா஫ல் இருந்ொல் அது நி௅ய஬ான உ௅஭ ஆகும்.  

மீ உ௅஭ (hypertext) : மீஉ௅஭ ஋ன்பது மு௅ன஬ம், உ௅஭ ஫ற்றும் மு௅ன஬ங்களுக்கு 

இ௅ை௄஬஬ான இ௅ணப்பு ஆகி஬லற்௅மக் ௃காண்டிருக்கும் அ௅஫ப்பாகும். 

4 

பல்லூைகத்தில் நிழற்பைகூறி௅ன ல  ப்படுத்துக  

பிட்௄஫ப் அல்யது ௃சவ்லக பைங்கள் (Bit mapor Raster image)   

கணினியில் பைங்க௅ரச் ௄சமிக்கும் ௃பாதுலான ஫ற்றும் ப஭ந்ெ லடிலம் பிட்௄஫ப் அல்யது 

௃சவ்லக பை஫ாகும். பிட்௄஫ப் ஋ன்பது பைப்புள்ளி (pixel) ஋ன்ம௅றக்கப்படும் சிறி஬ புள்ளிகளின் 

஋ளி஬ அணி஬ாகும். 

ெலக்ைர் பைங்கள் (Vector images)  

ல௅஭யும் கூறுகரான அல்யது ௃பாருள்கரான லரிகள், ௃சவ்லகங்கள், லட்ைங்கள் ஫ற்றும் பய 

பைங்க௅ர உருலாக்குலது ௃லக்ைர் பைங்களின் அடிப்ப௅ையில் அ௅஫யும்.  

5 

ல௅஭஬று – அ௅சவூட்ைல் ஫ற்றும் அென் சிமப்பம்சம்.  

அ௅ச஬ா பைங்க௅ர (Still images) மிக வி௅஭லாக காண்பிப்பென் மூயம் அலற்௅ம 

௃ொைர்ச்சி஬ான அ௅சவு ௄பான்ம உணர்௅ச ௃காடுக்கும் ௃ச஬௅ய அ௅சவூட்ைல் ஆகும். 

அ௅சவூட்ைல், தி௅஭௃பாருள் ஋ன்பது எரு ௃லக்ைர் பை஫ாகும்.  ஋ண் ஫ாற்மத்௅ெப் ப஬ன்படுத்தி 

எருங்கி௅ணப்புக௅ர (Coordinates) ல௅஭஬றுக்க பைத்துைன் அென் பா௅ெயின் இ஬க்கம் 

கணக்கிைப்படும். இ஭ண்டு ல௅க஬ான அ௅சவூட்ைல்கராலன:  பா௅ெ அ௅சவூட்ைல் (path 

animation) ஫ற்றும் சட்ைகம் அ௅சவூட்ைல் (Frame animation).  

6 

நிறற்பை ௄காப்பு லடிலங்க௅ரப் பட்டி஬லிடுக.  

1. TIFF(Tagged Image File Format)    

2. BMP(Bitmap)   

3. DIB(Device IndependentBitmap)  

4. GIF(Graphics Interchange Format)  

5. JPEG (Joint Photographic Experts Group)  

6. TGA(Tagra)  

7. PNG(Portable Network Graphics)  

7 

எளி ௄காப்பு லடிலங்க௅ரப் பட்டி஬லிடுக.  

1. WAV (Waveform Audio File Format)    

2. MP3 (MPEG layer-3 Format)        

3. OGG  

4. AIFF (Audio Interchange File Format)    

5. WMA (Windows Media Audio)    

6. RA (Real Audio Format) 

8 

எளிக்காட்சி ௄காப்பு லடிலங்க௅ரப் பட்டி஬லிடுக.  

1.AVI (Audio/Video Interleave)  

2. MPEG (Moving Picture Experts Group)  

9 

ல௅஭஬று – பல்லூைக உருலாக்கம்.  

பல்லூைகத்௅ெ உருலாக்குலெற்கு ௄பாது஫ான ௄ந஭ம் ஫ற்றும் திம௅஫஬ான திட்ைமிைல் 

ஆகி஬௅ல ௄ெ௅லப்படுகின்மன. இது திட்ைப்பணி சுமூக஫ாக ௃ொை஭வும் ஫ற்றும் ெகலல் இயக்கு 

பார்௅ல஬ாரர்க௅ரச் ௃சன்ம௅ை஬வும் உறுதி௃சய்கிமது. 

10 

பல்லூைக உருலாக்க குழு உறுப்பினர்க௅ர பட்டி஬லிடுக.  

1. ெ஬ாரிப்பு ௄஫யாரர் 2. ௃பாருரைக்க லல்லுநர் 3. ஸ்கிரிப்ட் ஋ழுத்ொரர் 4. உ௅஭ பதிப்பாரர் 5. 

பல்லூைக லடில௅஫ப்பாரர் 6. கணினி ல௅஭க௅ய க௅யஞர் 7. எலி ஫ற்றும் எளிக்காட்சி 

லல்லுநர் 8. கணினி நி஭யர் 9. ல௅ய லல்லுநர். 
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பகுதி இ 

III எரு பத்தி஬ரவில் வி௅ை஬ளிக்கவும். 

1 

பல்லூைக கூறுக௅ர சுருக்க஫ாக விலரி.  

பல்லூைகம் உ௅஭,  நிறற்பைம், எலி, எளி ஫ற்றும் அ௅சவூட்ைல் ஆகி஬ ஍ந்து முக்கி஬க் 

கூறுக௅ரக் ௃காண்டுள்ரது.  

Dynamic Elements:Video,Animation,Audio  

Static Elements:Text,Graphics  

2 

அ௅சவூட்டின் சிமப்பம்சங்கள் ஫ற்றும் ௃ொழில் நுட்பங்க௅ர விலரிக்கவும்.  

அ௅ச஬ா பைங்க௅ர (Still images) மிக வி௅஭லாக காண்பிப்பென் மூயம் அலற்௅ம 

௃ொைர்ச்சி஬ான அ௅சவு ௄பான்ம உணர்௅ல ௃காடுக்கும் ௃ச஬௄ய அ௅சவூட்ைல் ஆகும். 

அ௅சவூட்ைலில், தி௅஭௃பாருள் ஋ன்பது எரு ௃லக்ைர் பை஫ாகும். ஋ண் ஫ாற்மத்௅ெப் ப஬ன்படுத்தி 

எருங்கி௅ணப்புக௅ர (Coordinates) ல௅஭஬றுக்க பைத்துைன் அென் பா௅ெயின் இ஬க்கம் 

கணக்கிைப்படும். இ஭ண்டு ல௅க஬ான அ௅சவூட்ைல்கராலன: பா௅ெ அ௅சவூட்ைல் (path 

animation) ஫ற்றும் சட்ைகம் அ௅சவூட்ைல் (Frame animation).  

3 

உருலாக்க குழு உறுப்பினர்களின் பணிகள் ஫ற்றும் ௃பாறுப்புக௅ரப் பற்றி ஋ழுதுக.  

பல்லூைக உருலாக்கத்தில் அதிகபட்ச பய௅ன உ஬ர்ெ஭ திம௅஫யுைன் ௃பறும் ல௅கயில் குழு 

உறுப்பினர்க௅ர ௄஫யாண்௅஫ ௃சய்லது கட்ைா஬஫ாகும். நல்ய ெ஭஫ான உ஬ர்ந்ெ பல்லூைக 

உருலாக்க ப஬ன்பாட்டிற்கு பின்லரும் உறுப்பினர்க௅ரக் ௃காண்ை லல்லுநர் குழு 

௄ெ௅லப்படுகிமது.  

1. ெ஬ாரிப்பு ௄஫யாரர் 2. ௃பாருரைக்க லல்லுநர் 3. ஸ்கிரிப்ட் ஋ழுத்ொரர் 4. உ௅஭ பதிப்பாரர் 

5. பல்லூைக லடில௅஫ப்பாரர் 6. கணினி ல௅஭க௅ய க௅யஞர் 7. எலி ஫ற்றும் எளிக்காட்சி 

லல்லுநர் 8. கணினி நி஭யர் 9. ல௅ய லல்லுநர்  

4 

பல்லூைகத்தில் உள்ர பல்௄லறு ௄காப்பு லடிலங்கள் பற்றி விலரிக்கவும்.  

உ௅஭ லடிலங்கள்  

1. RTF(Rich Text Format) 2. Plain Text  

நிறற்பை லடிலங்கள்  

1.TIFF (Tagged Image File Format)  2. BMP (Bitmap) 3. DIB (Device IndependentBitmap) 4. GIF 

(Graphics Interchange Format)   5. JPEG (Joint Photographic Experts Group)   6. TGA (Tagra)    

7. PNG (Portable Network Graphics)  

இயக்க எலி ௄காப்பு லடிலங்கள்  

1. WAV (Waveform Audio File Format)     2. MP3 (MPEG layer-3 Format)    3. OGG   4. AIFF 

(Audio Interchange File Format) 5. WMA (Windows Media Audio)    6. RA (Real Audio Format)  

இயக்க எளிக்காட்சி ௄காப்பு லடிலங்கள்  

1.AVI(Audio/Video Interleave) 2. MPEG(Moving Picture Experts Group)   
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பகுதி – ஈ 

IV எரு பக்க அரவில் விரை஬ளிக்கவும்  

1 

பல்லூைக ௃ச஬ல்கள் பற்றி விரிலாக விரக்கவும்.  

பல்லூைகத்௅ெ உருலாக்குலெற்கு ௄பாது஫ான ௄ந஭ம் ஫ற்றும் திம௅஫஬ான திட்ைமிைல் 

ஆகி஬௅ல ௄ெ௅லப்படுகின்மன.  இது திட்ைப்பணி சுமூக஫ா ௃ொை஭வும் ஫ற்றும் ெகலல் 

இயக்கு பார்௅ல஬ாரர்க௅ரச் ௃சன்ம௅ை஬வும் உறுதி ௃சய்கிமது. சிக்கயான பல்லூைக 

திட்ைங்க௅ர உருலாக்குலெற்கான படிநி௅யகள் பின்லரு஫ாறு.  

1. கருத்துரு பகுப்பாய்வு ஫ற்றும் திட்ைமிைல்  

2. திட்ை லடில௅஫ப்பு  

3. முன்-உருலாக்குெல்  

4. ல஭வு-௃சலவு திட்ைமிைல்  

5. பல்லூைகத்௅ெ உருலாக்கும் குழு  

6. லன்௃பாருள் / ௃஫ன்௃பாருள் ௄ொோ்ந்௃ெடுத்ெல்  

7. ௃பாருரைக்கத்௅ெ ல௅஭஬றுத்ெல்  

8. கட்ை௅஫ப்௅ப ெ஬ார் ௃சய்ெல்  

9. உருலாக்குெல்  

10. ௄சாதித்ெல்  

11. ஆலணப்படுத்துெல்  

12. பல்லூைக திட்ைத்௅ெ லறங்குெல்  

2 

அ௅சவூட்ைல் நுட்பங்கள் பற்றி விரிலாக விலரிக்கவும்.  

அ௅ச஬ா பைங்க௅ர (Still images) மிக வி௅஭லாக காண்பிப்பென் மூயம் அலற்௅ம 

௃ொைர்ச்சி஬ான அ௅சவு ௄பான்ம உணர்௅ல ௃காடுக்கும் ௃ச஬௄ய அ௅சவூட்ைல் ஆகும். 

அ௅சவூட்ைலில், தி௅஭௃பாருள் ஋ன்பது எரு ௃லக்ைர் பை஫ாகும். ஋ண் ஫ாற்மத்௅ெப் 

ப஬ன்படுத்தி எருங்கி௅ணப்புக௅ர (Coordinates) ல௅஭஬றுக்க பைத்துைன் அென் பா௅ெயின் 

இ஬க்கம் கணக்கிைப்படும். கு௅மந்ெபட்ச சட்ைக விகிெம் (Framerate) 16 சட்ைங்கள் விநாடி ஋ன 

இருந்ொல் ௃஫ன்௅஫஬ான ௄ொற்மத்௅ெக் ௃காடுக்கும். இ஬ற்௅க ௄ொற்மத்திற்கு 

கு௅மந்ெபட்சம் விநாடிக்கு 25 சட்ைகங்கராக இரு அல்யது முப்பரி஫ாணங்க௅ரக் ௃காண்ைது.  

தி௅஭யில் X ஫ற்றும் Y அச்சுகளுக்கி௅ை௄஬஬ான ப஭ப்பில் இருபரி஫ாண அ௅சவூட்ைல் 

நிறற்பைத்௅ெ உயி௄஭ாட்ை஫ாக ௃காண்டு லருகிமது. முப்பரி஫ாண அ௅சவூட்ைத்தில் X, Y 

஫ற்றும் Z ஆகி஬ மூன்று அச்சுகளுக்கி௅ை௄஬ உயி௄஭ாட்ைம் ந௅ை௃பறுகிமது. இ஭ண்டு 

ல௅க஬ான அ௅சவூட்ைல்கராலன  

பா௅ெ அ௅சவூட்ைல்  : ஫ாமாெ பின்னணி௅஬க் ௃காண்ை தி௅஭யில் எரு ௃பாரு௅ர 

நகர்த்துல௅ெ உள்ரைக்கி஬து பா௅ெ அ௅சவூட்ைல் ஆகும்.  

சட்ைக அ௅சவூட்ைல்  :  இந்ெ அ௅சவூட்டில், பய ௃பாருட்கள் எ௄஭ ச஫஬த்தில் நகர்லெற்கு 

அனு஫திக்கிமது ஫ற்றும் பின்னணி அல்யது ௃பாருள்களும் ஫ாறுகிமது.  

3 

அ௅சவூட்ைல் தி௅஭ப்பைது௅மயில் உள்ர லாய்ப்புகள் பற்றி கண்ைறி஬வும்.  

௃பாழுது௄பாக்கு ௃ொழில் து௅மயில் குறிப்பிைத்ெக்க முன்௄னற்மத்திற்கு பல்லூைக 

௃ொழில்நுட்பம் முக்கி஬ கா஭ண஫ாகும். இந்ெ ௃ொழில் நுட்ப஫ானது லா௃னாலி, ௃ொ௅யக்காட்சி, 

ஆன்௅யன் வி௅ர஬ாட்டு, ௄ெ௅லப்படும் எளிக்காட்சி ௄பான்ம அ௅னத்து ல௅க஬ான 

௃பாழுது ௄பாக்கு அம்சங்களில் ௄ெ௅லப்படுகின்மது. ௄ெ௅லப்படும் எளிக்காட்சி அல்யது 

௄ெ௅லப்படும் தி௅஭ப்பைத்௅ெ வீடுகளில் உள்ர ௃ொ௅யக்காட்சி ௃பட்டிக்கு ெனிப்பட்ை 

மு௅மயில் துலங்குலது எரு ௄ச௅ல஬ாகும். தி௅஭ப்பைங்கள் ௅஫஬ ௄ச௅ல஬கத்தில் 

௄சமிக்கப்பட்டு ௃ொைர்பு ல௅ய஬௅஫ப்பின் மூயம் அனுப்படுகின்மது. ௃ொைர்பு ல௅ய஬௅஫ப்பில் 

இ௅ணக்கப்பட்டுள்ர ௃சட்-ைாப் பாக்ஸ் (Set Top Box) ஆனது இயக்க ெகலல்க௅ர எப்பு௅஫ 

ெகலல்கராக ஫ாற்றி ௃ொ௅யக்காட்சி ௃பட்டிக்கு உள்ளீடு ௃சய்கின்மது.  
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பல்லூைக உருலாக்க குழுவின் பணிகள் ஫ற்றும் ௃பாறுப்புகள் விரிலாக ஋ழுதுக. 

பல்லூைக உருலாக்கத்தில் அதிகபட்ச பய௅ன உ஬ர்ெ஭ திம௅஫யுைன் ௃பறும் ல௅கயில் குழு 

உறுப்பினர்க௅ர ௄஫யாண்௅஫ ௃சய்லது கட்ைா஫ாகும். நல்ய ெ஭஫ான உ஬ர்ந்ெ பல்லூைக 

உருலாக்க ப஬ன்பாட்டிற்கு பின்லரும் உறுப்பினர்க௅ரக் ௃காண்ை லல்லுநர் குழு 

௄ெ௅லப்படுகிமது.  

1. ெ஬ாரிப்பு ௄஫யாரர் : பல்லூைக உருலாக்குலல், குறித்ெ ௄ந஭த்தில் முழு ெ஭த்துைன் 

பல்லூைக திட்ை உருலாக்கத்௅ெ ல௅஭஬றுப்பது ஫ற்றும் எருங்கி௅ணப்பது ெ஬ாரிப்பு 

௄஫யாரரின் பங்கு ஆகும்.  

2. ௃பாருரைக்க லல்லுநர் : ௃பாருரைக்க லல்லுநர் ஋ன்பலர் ஌ற்கன௄ல திட்ைமிைப்பட்ை 

ப஬ன்பாட்டின் ௃பாருரைகத்௅ெப் பற்றி஬ அ௅னத்து ஆ஭ாய்ச்சி ௃ச஬ல்பாடுக௅ரயும் 

௃சய்லெற்கு ௃பாறுப்பானலர் ஆலார்.  

3. ஸ்கிரிப்ட் ஋ழுத்ொரர் : எளிக்காட்சி ஫ற்றும் பைச்சுருள் ஸ்கிரிப்ட்கள் ௃ொைர்ச்சி஬ான 

லரி௅சயிலுள்ர நிகழ்வுக௅ரக் குறிக்கும். ஸ்கிரிப்ட் ஋ழுத்ொரர் கருத்துருக்க௅ர 

முப்பரி஫ான சூறல்களில் காட்சிப்படுத்துகிமார்.  

4. உ௅஭ பதிப்பாரர் (Text Editor) : பல்லூைக உருலாக்குலதின் ௃பாருரைக்கம் ஋ப்௃பாழுதும் 

ெருக்க ரீதி஬ான ஏட்ை஫ாக இருத்ெல் ௄லண்டும்.  

5. பல்லூைக லடில௅஫ப்பாரர் : பல்லூைக லடில௅஫ப்பாரர் பல்லூைகத்தின் அ௅னத்து 

அடிப்ப௅ைத் ௃ொகுதிகரான ல௅஭க௅ய, உ௅஭, எலி, இ௅ச,  எளிக்காட்சி, பு௅கப்பைம் 

஫ற்றும் ப௅ைப்பாக்க ௃஫ன்௃பாரு௅ரப் ப஬ன்படுத்தி அ௅சவூட்ைல் ௄பான்மலற்௅ம 

எருங்கி௅ணப்பார் .  

6. கணினி ல௅஭க௅ய க௅யஞர் : நி஭லின் ல௅஭க௅ய கூறுகரான பின்னணி, புல்யட்கள், 

௃பாத்ொன்கள், பாைப்பதிப்பாய்வு,  3-D ௃பாருள்கள், அ௅சவூட்ைல் ஫ற்றும் சின்னங்கள் 

ஆகி஬லற்௅மக் ௅க஬ாளும் பங்கி௅ன கணினி ல௅஭க௅ய க௅யஞர் லகிக்கிமார்.  

7. எலி ஫ற்றும் எளிக்காட்சி லல்லுநர் : ஋டுத்து௅஭த்ெல் ஫ற்றும் ௄சமிக்கப்பட்ை 

எளிக்காட்சிக௅ரப் பல்லூைக நிகழ்த்துெலில் ௅க஬ாரத் ௄ெ௅லப்படுபல௄஭ எலி ஫ற்றும் 

எளிக்காட்சி லல்லுநர் ஆலார்.  

8. கணினி நி஭ய  : கணினி நி஭யர் ௃பாருத்ெ஫ான ௃஫ாழியில் குறிமு௅ம அல்யது ஸ்கிரிப்ட் 

லரிக௅ர ஋ழுதுகிமார். இந்ெ ஸ்கிரிப்ட்கள் லறக்க஫ாக சிமப்பு ௃ச஬ல்பாடுக௅ர 

உருலாக்கும்.  

9. ல௅ய லல்லுநர் : எரு இ௅ண஬ ல௅யப்பக்கத்௅ெ உருலாக்கி அ௅ெ ப஭ா஫ரிப்பது ல௅ய 

லல்லுநரின் ௃பாறுப்பாகும் 
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பல்லூைக ௄காப்பில் உள்ர ௃லவ்௄லறு ௄காப்பு லடிலங்க௅ர விலரிக்கவும்.  

உ௅஭ லடிலங்கள்  

1. RTF (Rich Text Format) ௅஫க்௄஭ாசாப்ட் நிறுலனத்ொல் 1987 ஆம் ஆண்டு பி஭சுரிக்கப்பட்ை 

ெ஬ாரிப்புகளின் குறிப்புகள் ஫மறும் குறுக்கு பணித்ெர ஆலணங்களின் பரி஫ாற்மங்க௄ராடு 

அறிமுகப்படுத்ெப்பட்ைது.  

2. Plain Text ௄காப்புக௅ர பய உ௅஭ பதிப்பான்களில் திமக்கயாம், படிக்கயாம் ஫ற்றும் 

பதிப்பாய்வு ௃சய்஬யாம். 

நிறற்பை லடிலங்கள்  

1. TIFF (Tagged Image File Format) இந்ெ லடிலம் கணிப்௃பாறி பதிப்பக உயகில் 

௃பாதுலானது ஆகும். இது ௃பாதுலாக அ௅னத்து ௃஫ன்௃பாருள் ௃ொகுப்புக௅ர 

ஆெரிக்கிமது. 

2. BMP (Bitmap) இது ௃ொைக்கத்தில் விண்௄ைாஸ் 3.1-ல் ப஬ன்படுத்ெப்பட்ைது. இது மிகவும் 

௃பரி஬து ஫ற்றும் குறுக்க஫ற்மது ஋ன௄ல, இது அதிக ௃ெளிவுத்திமன் அல்யது ௃பரி஬ 

நிறற்பைங்களுக்காக ப஬ன்படுத்ெப்படுகிமது. 

3. DIB (Device IndependentBitmap) இந்ெ லடிலம் BMP-௅஬ எத்ெொகும். இது ௄காப்புக௅ர 
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பல்௄லறு சாெனங்களில் காண்பிக்க அனு஫திக்கமது. 

4. GIF (Graphics Interchange Format) ஋ன்பது குறுக்கப்பட்ை நிறற்பை லடில஫ாகும். 

௃பரும்பாயான கணினி லண்ண நிறற்பைங்கள் ஫ற்றும் பின்னனிகள் GIF 

௄காப்புகராகும். 

5. JPEG (Joint Photographic Experts Group) அதிகபட்ச நிறற்பை குறுக்கத்௅ெ 

அ௅ைலெற்காக லடில௅஫க்கப்பட்டுள்ரது. இது பு௅கப்பைம், இ஬ற்௅க 

க௅ய௄ல௅யப்பாடு ஫ற்றும் அ௅ெப்௄பான்ம ௃பாருள்களுைன் நன்மாக ௄ல௅ய 

௃சய்யும். ஆனால் ஋ழுத்துமு௅ம, உயி௄஭ாட்ை஫ான ல௅஭ெல் அல்யது ஋ளி஬ 

௄கலிச்சித்தி஭ங்களில் கு௅மந்ெ அரவில் ௃ச஬ல்படும். 

6. TGA (Tagra) இது அதிக ௃ெளிவுத்திமன் நிறற்பைங்களுக்கான முெல் பி஭பய஫ான 

லடில஫ாகும். ௃பரும்பான்௅஫஬ான எளிக்காட்சி பிடிப்பு பய௅ககள் TGA-௅ல 

ஆெரிக்கின்மன. 

7. PNG (Portable Network Graphics) இது கு௅மந்ெ இறப்பு, சிறி஬து ஫ற்றும் நன்கு 

குறுக்கப்பட்டு ௃சவ்லக நிறற்பைங்கராக ௄சமிக்கப்படும் எரு நீட்டிப்பு ௄காப்பு 

லடில஫ாகும். இது GIF-க்கு ஫ாற்மாக ௃ச஬ல்படுகிமது. ஫ற்றும் TIFF-ன் பய ௃பாதுலான 

ப஬ன்க௅ரயும் ஫ாற்றுகிமது. 

இயக்க எலி ௄காப்பு லடிலங்கள்  

1. WAV (Waveform Audio File Format)     இது விண்௄ைாஸில் குறுக்கப்பைாெ எலி 

௄காப்புக௅ரச் ௄சமிக்கும் மிகவும் பி஭பய஫ான எலி ௄காப்பு லடில஫ாகும். 

2. MP3 (MPEG layer-3 Format)    இ௅ச௅஬ ௄சமிக்கவும் பதிவிமக்கம் ௃சய்஬வும் மிகவும் 

பி஭பய஫ான லடிலம் MPEG Layer-3 லடில஫ாகும். 

3. OGG சிமந்ெ ஏட்ைத்தி௅ன அ௅ைலெற்காக லடில௅஫க்கப்பட்ை இயலச திமந்ெ மூய 

௃காள்கயன் (Container) லடில஫ாகும். 

4. AIFF (Audio Interchange File Format) Mac ப஬ன்படுத்தும் WAV ௄காப்புக௅ரப் ௄பால் 

Apple நிறுலனம் ப஬ன்படுத்தும் ெ஭஫ான எலி லடிலம் இது ஆகும். 

5. WMA (Windows Media Audio) மிகவும் பி஭பய஫ான WMA லடிலத்தின் உரி௅஫஬ாரர் 

௅஫க்௄஭ா சாப்ட் ஆகும். பதிப்புரி௅஫ (Copy right) பாதுகாப்பிற்காக DRM (Digital Right 

Management) திமன்க௄ராடு லடில௅஫க்கப்பட்டுள்ரது.   

6. RA (Real Audio Format) லடிலம் இ௅ண஬த்தில் எலியின் ஏட்ைத்திற்காக 

லடில௅஫க்கப்பட்ைொகும். இயக்க எலி லரங்க௅ரப் ௃பாதுலாக கணினிக் 

௄காப்புகராக கணினியின் லன்லட்டு அல்யது CD / DVD-களில் ௄சமிக்கப்படுகிமது. 

இயக்க எளிக்காட்சி ௄காப்பு லடிலங்கள்  

1. AVI (Audio/Video Interleave) இது எரு விண்௄ைாஸிற்கான எரு எளிக்காட்சி ௄காப்பு 

லடில஫ாகும். இங்கு, எலி ஫ற்றும் பைத்தின் கூறுக௅ரக் ௄காப்பில் ஫ாற்று ௃நடுலரி௅ச 

௃ொகுப்பில் (interleave chunk) ௄சமிக்கப்படுகிமது. 

2. MPEG (Moving Picture Experts Group) ஋ன்பது இயக்க எளிக்காட்சி ஫ற்றும் எலி 

குறுக்கத்௅ெ ISO (International Standards Organization) குழுவின஭ால் உருலாக்கப்படும் 

எரு ெ஭நி௅ய ஆகும். 
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பகுதி – அ 

I. சரி஬ான வி௅ை௅஬த்    ந்௃ெடுத்து ஋ழுதுக  

1 

Adobe Flash நி஭ல் மூயம் நீங்கள் ஋ெ௅ன உருலாக்க முடியும்? 

 )            )                

 )           ஈ)                 

2 
Flash பணியிை ௅஫஬த்தின் நடுவில் உள்ர ௃பரி஬ ௃லள்௅ர ௃சவ்லக லடிலம் -----------   

 )            )                )         ஈ)       

3 
எரு புதி஬ Flash ஆலணத்௅ெ ஋வ்லாறு உருலாக்குலாய் ?  

 ) Insert → New     ) Ctrl+W      ) File → New       ஈ) Ctrl+D 

4 

௃காைாநி௅ய பணித்ெரத்தின் நிமம் ௃லள்௅ர.  இ௅ெ ஫ாற்ம --------- ௄ெர்ந்௃ெடுக்கவும்.  

 ) Modify → Document Properties        ) Modify → Document 

 ) Edit → Document     ஈ) Edit → Document Properties 

5 
Flash ௄காப்புகள் --------- ஋னவும் அ௅றக்கப்படுகிமது.  

 ) Flash Guides      ) Flash Movies         ) Flash Rulers         ஈ) Flash Timeline 

6 
கலனத்௅ெ ஈர்க்கும் ல௅கயியான பொ௅கக௅ர (Banner) --------- மூயம் உருலாக்கயாம்.  

 ) Access      ) Word        ) Flash        ஈ) Excel 

7 
Flash ௄காப்பின் ௃காைாநி௅ய விரிலாக்கம் -------- 

 ) .shw     ) .doc    ) .xls   ஈ) .fla 

8 

Flash-ல் நீங்கள் உருலாக்கும் ஋ந்ெ உள்ரைக்க஫ாயினும் அது ------- ஋ன்று 

அ௅றக்கப்படுகிமது. 

 )            )           )             ஈ)        

9 
நீங்கள் துரி௅க௅஬ ப஬ன்படுத்தி ல௅஭லது ௄பான்று ௄காடுக௅ர ல௅஭஬ உெவும் கருவி  

 ) Brush Tool            ) Lasso Tool        ) Text Tool       ஈ) Zoom Tool 

10 
கீழ்கண்ை ஋ந்ெ கருவி, கருவிப் பயகத்தில் எ௄஭ குழுவில் இைம்௃பமவில்௅ய.  

 ) Rectangle Tool       ) Oval Tool          ) Line Tool        ஈ) PolyStar Tool 

11 

Oval கருவி௅஬ ப஬ன்படுத்தி ஋வ்லாறு எரு லட்ைத்௅ெ ல௅஭஬யாம்?  

 ) Ctrl                         

 ) Alt                         

 ) P                         

ஈ) Shift                         

12 

஋ந்ெ கருவி எரு ல௅஭பைத்தின் குறிப்பிட்ை பகுதி௅஬ ௃பரிொக்கி காட்டும்.  

 ) The Free Transform Tool       ) The Rectangle tool 

 ) The Zoom tool         ஈ) The Selection tool 

II ௄காடிட்ை இைங்க௅ர நி஭ப்புக 

1 
பணித்ெரத்தில் --------- கருவி௅஬ ப஬ன்படுத்தி எரு ௄நாோ்௄காட்௅ை ல௅஭஬யாம். (Line Tool 

௅யன் கருவி) 

2 
எரு லட்ைம் ல௅஭஬ Oval கருவி௅஬ கிளிக் ௃சய்து ----------- வி௅ச௅஬ அழுத்தி ௃காண்௄ை 

நகர்த்ெ ௄லண்டும். (Shift) 

3 நீங்கள் -------------- கருவி மூயம் சது஭ம் ல௅஭஬ முடியும். (Rectangle) 

4 சாொ஭ன அழிப்பான் ௄பான்று ௃பாருட்க௅ர அழிப்பெற்கு ---------- உெவுகிமது (Eraser) 

5 Flash ௄காப்புகள் ொனாக௄ல ------------ விரிவுைன் உருலாகும். (.fla) 
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பகுதி – ஆ 

II. மூன்று லரிகளில் வி௅ை஬ளிக்கவும். 

1 

Flash ஋ன்பது ஋ன்ன?  

Adobe Flash Professional CS6 அனி௄஫ளன்க௅ர உருலாக்க ப஬ன்படும் ௃஫ன்௃பாருள். 

அடிப்ப௅ை ௃பாருட்க௅ர ல௅஭஬வும் காட்சிக௅ர உருலாக்கவும் ப஬ன்படுத்ெக்கூடி஬ கருவிகள் 

உள்ரன. இது (Adobe) அ௄ைாப் நிறுலனத்ொல் உருலாக்கப்பட்டுள்ரது.  

2 

Adobe ProfessionalFlash CS6஍ ௃ொைங்க ௄ெ௅ல஬ான படிநி௅யக௅ர ஋ழுதுக.  

அ௄ைாப் ஃப்ராஷ் ப்௃஭ாப்பளனல் CS6 ௅஬ ௃ொைங்க start→All programs→Adobe Flash 

professional CS6 – ௅஬ ௄ெர்வு ௃சய்஬வும்.  

1. ஃப்ராஷ்-ல் நீங்கள் ல௅஭லெற்கு (அ) அ௅சவூட்ைம் ௃சய்லெற்கு முன்பு முெலில் நீங்கள் எரு 

புதி஬ ஆலணத்௅ெ உருலாக்க ௄லண்டும்.  

ல஭௄லற்பு தி௅஭யிலிருந்௄ொ (welcome screen) (அ) தி௅஭யின் ௄஫ற்பகுதியில் உள்ர File 

பட்டியிலிருந்௄ொ எரு புதி஬ ஆலணத்௅ெ உருலாக்க முடியும்.  

2. எரு புதி஬ ஆலணத்௅ெ File பட்டியிலிருந்து உருலாக்க file→New–௅஬ ௄ெர்ந்௃ெடுத்ொல் 

New Document உ௅஭஬ாைல் ௃பட்டி ௄ொன்றும். அதில் General ெத்ெலின் கீழ் உள்ர 

ActionScript 3.0 –௅஬ ௄ெர்ந்௃ெடுத்து OK  ௃பாத்ொ௅ர கிளிக் ௃சய்ொல் எரு புதி஬ ஆலணம் 

உருலாகும்.  

3 

காயக்௄காட்டின் (Time line) ன் ௄ெ௅ல ஋ன்ன?  

(Timeline) காயக்௄காடு ஋ன்பது Flash-ன் மிக முக்கி஬஫ான கூறுகளில் என்மாகும். இது 

௄஫௅ைக்கு கீ௄ற அ௅஫ந்துள்ரது. இது எவ்௃லாரு உறுப்பு ௄ொற்மத்௅ெயும் அனி௄஫ள௅னயும் 

குறிக்க ப஬ன்படுத்ெப்படுகிமது. 

பகுதி – இ 

III. எரு பத்தி஬ரவில் வி௅ை஬ளிக்கவும். 

1 

கீழ்கண்ை ௃ச஬ல்க௅ர ௃சய்஬ உெவும் கருவிக௅ர கூறுக.  

அ. ௄காடு ல௅஭ெல்  

Line கருவி (N)  

இது ௄நர்௄காடுக௅ர ல௅஭லெற்குப் ப஬ன்படுகிமது. நீங்கள் ௃சங்குத்து, கி௅ை஫ட்ை ஫ற்றும் 

450 மூ௅யவிட்ை ௄காடுக௅ர ல௅஭லெற்கு Shift வி௅ச௅஬ அழுத்திப்பிடிக்க ௄லண்டும்.  

ஆ. ெற்௄பாக்கு உருலம் ல௅ரெல்  

Pencil கருவி இது ெற்௄பாக்காக (freehand) ௄காடுகள் ஫ற்றும் லடிலங்க௅ர ல௅஭஬ப் 

ப஬ன்படுகிமது. ௃பன்சில் மு௅ம (Mode) விருப்பத்தில் உள்ர பட்டி பின்லரும் 

கட்ை௅ரக௅ர காட்டும்.  

 Straighten -௄நர்க்௄காட்டி௅ன ல௅஭லெற்கு,  

 Smooth – ல௅ய ௄காட்டி௅ன ல௅஭லெற்கு  

 Ink - அரவு௄காயற்ம ல௅஭பைங்கரர ஋ந்ெ ஫ாற்மமும் இன்றி ல௅஭஬  

இ. நீங்கள் ல௅஭ந்ெலற்௅ம அழித்ெல்  

Eraser கருவி (E)  இது ௄காடுகள் ஫ற்றும் உட்ப஭ப்புக௅ர (Fill) அழிக்கப் ப஬ன்படுகிமது  

2 

Zoom கருவி ஫ற்றும் Hand கருவி ௄லறுபாடுக௅ரக் கூறுக.  

Zoom கருவி (Z)  

இது ௄஫௅ைப்பகுதி௅஬ ௃பரிொக ஫ாற்மப் ப஬ன்படுகிமது. இது ௄஫ையில் எரு பகுதியில் கிளிக் 

௃சய்லென் மூயம் அெ௅ன ௃பரிொக்கயாம். Alt வி௅ச௅஬ அழுத்திப்பிடித்து ௄஫௅ையில் கிளிக் 

௃சய்ொல் அெ௅ன சிறிொக்கயாம்.  

Hand கருவி (H)  

இது ௄஫௅ை௅஬ நகர்த்ெ ப஬ன்படுகிமது. எட்டு பய௅கயில் ஋ங்கு ௄லண்டு஫ானாலும் 

பணித்ெரத்௅ெ இழுத்து நகர்த்ெயாம்.  
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பகுதி – ஈ 

IV. எரு பக்க அரவில் வி௅ை஬ளிக்கவும் 

1 

Flash சன்னல் தி௅஭யில் ப஬ன்படுத்தும் கூறுக௅ர விலரி.  

ஃப்௃ராஷ் சன்னல் தி௅஭ கூறுகள் (அ) பகுதிகள்  

ஃப்ராஷ் சன்னல் தி௅஭ நான்கு பகுதிகராக (அ) கூறுகராக பிரிக்கப்பட்டுள்ரது. அ௅ல  

1. பணித்ெரம் ஫ற்றும் எட்டுப்பய௅க (Stage and paste Board)  

2. காயக்௄காடு (Timeline)  

3. கருவிகள் பயகம் (Tools Panel)  

4. பண்பு ௄சாதிப்பான் (Property Inspector)  

பணித்ெரம் ஫ற்றும் எட்டுப்பய௅க (பணிப்பகுதி) (The Stage and Pasteboard (work area)  

உங்கள் பணித்ெரத்தின் நடுவில் உள்ர ௃சவ்லக ௃லள்௅ரப்பகுதி ௄஫௅ை (Stage) ஋ன 

அ௅றக்கப்படுகிமது. அ௅சவுப் பைத்திற்கான அ௅சவூட்ைங்கள், ௃பாருட்கள் ஫ற்றும் காட்சிகள் 

ஆகி஬லற்௅ம உருலாக்க, பதிப்பிக்க இருத்தி௅லக்க ஫ற்றும் இ஬க்க இந்ெ ௄஫௅ை உெவுகிமது.  

காயக்௄காடு (Time Line)  

காயக்௄காடு ஋ன்பது ஃப்ராஷ்-ன் மிக முக்கி஬஫ான கூறுகளில் என்மாகும். இது பணித்ெரப் 

பகுதியின் கீ௄ற அ௅஫ந்துள்ரது. இது எவ்௃லாரு உறுப்பின் ௄ொற்மத்௅ெயும் ஫ற்றும் 

அ௅சவூட்ைத்௅ெயும் ௃ெளிலாக காட்ை ப஬ன்படுகிமது.  

ஃப்௃ராஷ் கருவிகள் பயகம் (The Flash Tools Panel)  

ஃப்ராஷ் கருவிகள் பயகம் நீங்கள் ௄஫௅ையில் ல௅஭க௅ய௅஬ உருலாக்க, ௄ெர்ந்௃ெடுக்க (அ) 

பதிப்பிக்கத் ௄ெ௅ல஬ான கருவிக௅ர ௃காண்டுள்ரது.  

பண்பு ௄சாதிப்பான் (Property inspector)  

இது ௃காைாநி௅ய஬ாக Flash பணியிைத்தின் லயது பக்கத்தில் ௄ொன்றும். இது 

நூயகப்பயகத்துைன் இ௅ணக்கப்பட்டிருக்கும். இது ௄ெர்ந்௃ெடுக்கப்பட்ை ௃பாருளின் பண்புகள் 

஫ற்றும் விருப்பங்க௅ரக் காட்டுல௄ொடு அலற்௅ம ஫ாற்மவும் அனு஫திக்கிமது.  

2 

Tools பயகத்தில் காணப்படும் கருவிகள் சியலற்௅ம விலரி.  

Selection  

கருவி (V) 

இந்ெ கருவி எரு ௃பாருள் (அ) எரு ௃பாருளின் பகுதி஬ாகி஬ ௃லளிக்௄காடு 

஫ற்றும் உட்ப஭ப்பு (Stroke & Fill) ஆகி஬லற்௅மத் ௄ெர்ந்௃ெடுக்க 

ப஬ன்படுகிமது. 

Free Transform 

கருவி (Q) 

இது ௃பாருள்க௅ர சுறற்ம, அரவிை, ல௅ரக்க ஫ற்றும் உருக்கு௅யக்க 

ப஬ன்படுகிமது. 

3D Rotation 

கருவி (W) 

இது ௄஫௅ையில் முப்பரி஫ாண ௃லளியில் சயனப்பைத் துண்டுகுக௅ர 

(Movie Clips) சுறற்றுலென் மூயம் முப்பரி஫ாண வி௅ரவுக௅ர உருலாக்க 

ப஬ன்படுகிமது. 

Lasso கருவி (L) சாொ஭ண஫ாக எரு ௃பாரு௅ரச் சுற்றில௅஭லென் (Freehand) மூயம், இது 

௃பாருள்க௅ர ௄ெர்ந்௃ெடுப்பெற்கு (அ) ௃பாருளின் எரு பகுதி௅஬ 

௄ெர்ந்௃ெடுப்பெற்கு ப஬ன்படுகிமது. 

Pen கருவி (P) இது நங்கூ஭ப் புள்ளிகள் ஋னப்படும்.  ௃ொைர்புள்ளிக௅ர உருலாக்குலென் 

மூயம்௄காடுகள் ஫ற்றும் ல௅஭௄காடுக௅ர ல௅஭லெற்கு ப஬ன்படுகிமது. 

Text கருவி (T) இது உ௅஭௅஬ உருலாக்க ஫ற்றும் பதிப்பிக்க ப஬ன்படுகிமது. 

Line கருவி (N)   இது ௄நர்௄காடுக௅ர ல௅஭லெற்குப் ப஬ன்படுகிமது. நீங்கள் ௃சங்குத்து, 

கி௅ை஫ட்ை ஫ற்றும் 450 மூ௅யவிட்ை ௄காடுக௅ர ல௅஭லெற்கு Shift 

வி௅ச௅஬ அழுத்திப்பிடிக்க ௄லண்டும். 

Rectangle  

கருவி (R) 

இது ௃சவ்லகம் ல௅஭஬ப் ப஬ன்படுகிமது. Shift அழுத்திப் பிடிப்பென் மூயம் 

சது஭ம் ல௅஭஬யாம். 
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3D Translation 

கருவி (G) 

இது ௄஫௅ையில் முப்பரி஫ாண ௃லளியில் சயனப்பைத் துண்டுக௅ர (Movie 

Clips) நகர்த்துலென் மூயம் முப்பரி஫ாண வி௅஭வுக௅ர உருலாக்கப் 

ப஬ன்படுகிமது. 

Oval கருவி (O) இது நீள்லட்ை லடிலங்க௅ர ல௅஭லெற்கு ப஬ன்படுகிமது. சரி஬ான 

லட்ைத்௅ெ ல௅஭லெற்கு Shift வி௅ச௅஬ அழுத்திப்பிடிக்க ௄லண்டும். 

Poly Star கருவி இது பய௄காணம் ஫ற்றும் நட்சத்தி஭ங்க௅ர ல௅஭஬ ப஬ன்படுகிமது. 

௃சவ்லகம், நீள்லட்ைம், பிரிமிட்டிவ் ௃சவ்லகம் ஫ற்றும் Poly Star கருவிகள் 

஋ல்யாம் எ௄஭ கருவியில் ௃ொகுக்கப்பட்டு கருவி பயகத்தில் உள்ரது. 

Pencil கருவி இது ெற்௄பாக்காக (freehand) ௄காடுகள் ஫ற்றும் லடிலங்க௅ர ல௅஭஬ப் 

ப஬ன்படுகிமது. 

Brush கருவி (B) இது தூரி௅ககள் ௄பான்ம ௄காடுகள் (Paint) ல௅஭லெற்கு ப஬ன்படுகிமது. 

Eraser கருவி (E) இது ௄காடுகள் ஫ற்றும் உட்ப஭ப்புக௅ர (Fill) அழிக்கப் ப஬ன்படுகிமது. 

Hand கருவி (H) இது ௄஫௅ை௅஬ நகர்த்ெ ப஬ன்படுகிமது. எட்டுபய௅கயில் ஋ங்கு 

௄லண்டு஫ானாலும் பணித்ெரத்௅ெ இழுத்து நகர்த்ெயாம். 

Zoom கருவி (Z) இது ௄஫௅ை பகுதி௅஬ ௃பரிொக ஫ாற்மப் ப஬ன்படுகிமது. இது ௄஫௅ையில் 

எரு பகுதியில் கிளிக் ௃சய்லென் மூயம் அெ௅ன ௃பரிொக்கயாம். Alt 

வி௅ச௅஬ அழுத்திப்பிடித்து ௄஫௅ையில் கிளிக் ௃சய்ொல் அெ௅ன 

சிறிொக்கயாம். 

Stroke Color 

கருவி 

இது ல௅஭஬ப்பட்ை ௃பாருள்களின் ௃லளிக்௄காட்டின் நிமத்௅ெ ஫ாற்றி 

அ௅஫க்கப் ப஬ன்படுகிமது. 

Fill Color கருவி இது ல௅஭஬ப்பட்ை ௃பாருள்களின் உட்ப஭ப்பின் லண்ணத்௅ெ ஫ாற்மப் 

ப஬ன்படுகிமது. 
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பகுதி – அ 

I சரி஬ான வி௅ை௅஬த்    ந்௃ெடுத்து ஋ழுதுக 

1 
ஆட்௄ைா௄கட் ஋ன்பது _________௃஫ன்   ருராகும்.  

 ) DTP    ) Computer-aided design (CAD) and drafting      ) Text Editing     ஈ) Video Editing 

2 
ஆட்௄ைா௄கட் 2016-஍ உருலாக்கி விற்ப௅ன ௃சய்யும் நிறுலனம் ________  

 ) Microsoft Corporation        ) Adobe, Inc.        ) Autodesk, Inc.       ஈ) Sun 

3 
சிலப்பு நிம ‚A‛ ௃பாத்ொ௅னக் கிளிக் ௃சய்ொல் ௄ொன்றும் பட்டி_________   

 ) Application           ) Edit          ) Layout         ஈ) Window 

4 
ப஬ன்பாட்டுப் பட்டியின் ௄஫ல் பகுதியில் ௄ொன்றும் பட்௅ை ஋து?  

 ) Menu       ) Search         ) Toolbar        ஈ) Title 

5 

கட்ை  ச் சார஭ம் ௄ொன்மவில்௅ய ஋னில் ஋ந்ெ வி௅சப்பய௅க குறுக்குலழிக௅ரப் ப஬ன்படுத்ெ 

௄லண்டும்?  

 ) Ctrl + 1        ) Ctrl + 9      ) Ctrl + 8       ஈ) Ctrl + 7 

6 

UCS ஋ன்பது ஋ென் குறுக்கம்?  

 ) User Coordinate System      ) User Currency System 

 ) User Control System          ஈ) User Computer System 

7 

கட்ைங்க௅ர (grid) காண்பிக்கவும், ஫௅மக்கவும் (ON or OFF) வி௅சப்பய௅கயில் ஋ந்ெ ௃ச஬ல்பாட்டு 

வி௅ச௅஬ அழுத்ெ ௄லண்டும்?  

 ) F1         ) F2         ) F3      ஈ) F7 

பகுதி – ஆ 

II. மூன்று லரிகளில் வி௅ை஬ளிக்கவும். 

1 

ஆட்௄ைா௄க௅ை ஋வ்௃லாறு ௃ொைங்குலாய்?  

ஆட்௄ைா௄கட் 2016-஍ ௃ொைங்க,  தி௅஭முகப்பில் உள்ர Auto CAD 2016 –English பணிக்குறி௅஬ 

இருமு௅ம கிளிக் ௃சய்஬ ௄லண்டும்.  

(அல்யது) Start → All Programs → Autodesk → AutoCAD 2016 → AutoCAD 2016 – English 

஋ன்ம லரி௅சயில் கிளிக் ௃சய்஬ ௄லண்டும். 

2 

ரிப்பனில் உள்ர அ௅னத்துப் ௃பாத்ொன்க௅ரயும் ஋ப்படி ஫௅மப்பாய்?  

1. முெல் மு௅ம஬ாக சிறிொக்குப் ௃பாத்ொ௅ன கிளிக் ௃சய்யும் ௄பாது ரிப்பன் ௃ொகுதிகள் ஫ற்றும் 

௄பனல் ௃பாத்ொன்களுைன் காட்சி஬ளிக்கும். 

2. இ஭ண்ைாலது மு௅ம஬ாக சிறிொக்குப் ௃பாத்ொ௅ன கிளிக் ௃சய்யும் ௄பாது, ௄பனல் 

௃பாத்ொன்கள் ௄பனல் ெ௅யப்புகராக ஫ாறும்.  

3 

ரிப்பனில் உள்ர எரு ௃பாத்ொன் மீது சுட்டுக்குறி௅஬ நிறுத்தும் ௄பாது ஋ன்ன ௄ொன்றும்?  

முெல் மு௅ம஬ாக சிறிொக்குப் ௃பாத்ொ௅ன கிளிக் ௃சய்யும் ௄பாது ரிப்பன் ௃ொகுதிகள் ஫ற்றும் 

௄பனல் ௃பாத்ொன்களுைன் காட்சி஬ளிக்கும். இப்௃பாழுது ௄பனல் ௃பாத்ொனின் மீது சுட்டி௅஬ 

நகர்த்தினால், அந்ெ ௄பனலில் உள்ர அ௅னத்துக் கருவிகளும் ௃ெரியும்.  

4 

UCS பணிக்குறி௅஬ ஋வ்லாறு நீக்குலாய்?  

இருபரி஫ாண ல௅஭பைங்களுக்கு UCS பணிக்குறி ௄ெ௅லப்படுலதில்௅ய. அப்௃பாழுது UCSICON 

கட்ை௅ர மூயம் அரெ நீக்கிவிையாம்.  

Command : ucsicon  

Enter an option : off 

www.Padasalai.Net                                                                   www.CBSEtips.in

Kindly send me your study materials to our email id - padasalai.net@gmail.com

Pa
da

sa
la

i.N
et

Pa
da

sa
la

i.N
et

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://www.padasalai.net/
https://www.padasalai.net/


 
 

 31 M.Sc.,M.Ed.,M.Phil.,  

 

5 
OSNAP-஍ ON ஫ற்றும் OFF ௃சய்லெற்கு ஋ந்ெ ௃ச஬ல்பாட்டு வி௅ச௅஬ப் ப஬ன்படுத்ெ ௄லண்டும்?  

OSNAP-஍ ON ஫ற்றும் OFF ௃சய்஬ F3 ௃ச஬ல்பாட்டு வி௅ச௅஬ப் ப஬ன்படுத்ெயாம். 

6 

௅யன் (LINE) கட்ை௅ர௅஬ப் ப஬ன்படுத்தும்௄பாது பய ௄காணத்௅ெ முடிக்கப் ப஬ன்படும் 

வி௅஭லான லழிமு௅ம௅஬க் கூறு.  

இ஭ண்டு அல்யது அெற்கு ௄஫ற்பட்ை ௃ொைர்ச்சி஬ான ௄காடுக௅ர ல௅஭யும் ௄பாது, Close 

விருப்ப஫ானது முெல் ௄காட்டின் ௃ொைக்கப் புள்ளி௅஬யும், க௅ைசி ௄காட்டின் முடிவுப் புள்ளி௅஬யும் 

இ௅ணக்கப் ப஬ன்படுகிமது. 

7 

௅யன் கட்ை௅ர ஫ற்றும் ௃஭க்ைாங்கல் கட்ை௅ர௅஬ப் ப஬ன்படுத்தி ௃சவ்லகம் ல௅஭யும்௄பாது 

஌ற்படும் ந௅ைமு௅ம சிக்கல்க௅ரக் கூறு. ஌ன் என்௅ம விட்டு ஫ற்௃மான்௅மப் ப஬ன்படுத்ெ 

௄லண்டும்?  

௅யன் கட்ை௅ர௅஬ப் ப஬ன்படுத்தியும் ௃சவ்லகம் ல௅஭஬ முடியும். ஆனால் அதில் சிய 

கு௅மபாடுகள் உள்ரன. ஋டுத்துக்காட்ைாக, ௄காண அரவுகள் 90 டிகிரி உள்ரனலா ஋ன 

சரிபார்க்க ௄லண்டும். ௄஫லும் எவ்௃லாரு ௄காடும் ெனித்ெனி ௃பாருராக இருக்கும். எரு ௄காட்டின் 

மீது கிளிக் ௃சய்ொல் அந்ெ௄காடு ஫ட்டு௄஫ ௄ெர்வு ௃சய்஬ப்படும். ஫ற்ம ௄காடுகள் ௄ெர்வு 

௃சய்஬ப்பைாது. ஆ௅க஬ால் ஆட்௄ைா௄கட் 2016இல் உள்ர RECTANG கட்ை௅ர, சரி஬ான ௄காண 

அரவுகளுைன் எரு ௃சவ்லகத்௅ெ எ௄஭ ௃பாருராக ல௅஭஬ லழி லகுக்கிமது. 

8 

ஆட்௄ைா௄கடில் எரு கட்ை௅ர ௃ச஬ல்பாட்டில் இருக்கும்௄பாது அதிலிருந்து ஋வ்லாறு 

௃லளி௄஬மயாம்?  

ESC வி௅ச௅஬ ஋ந்ெ ௄ந஭த்திலும் அழுத்ெ முடியும். எரு ௃ச஬ல் ௃ச஬ல்பாட்டில் இருக்கும் ௃பாழுது 

ESC வி௅ச௅஬ அழுத்தினால், அது அக்கட்ை௅ர௅஬ முடிவுக்குக் ௃காண்டு லரும். 

9 

ஆர்க் ஫ற்றும் சர்க்கிள் ௃பாத்ொன்கள் ஋ந்ெ ரிப்பன் கன்ட்௄஭ால் ௄பனலில் உள்ரன?  

Arc ஫ற்றும் Circle கருவிகள் அ௅னத்தும் ரிப்பனில் உள்ர Draw ௄பனலில் எரு குழுலாக 

இருக்கும். 

10 

ERASE கட்ை௅ர௅஬ உள்ளிட்ை பின், ஆட்௄ைா௄கட் உங்க௅ர ஋ன்ன ௃சய்஬ச் ௃சால்கிமது?  

எரு ௃பாரு௅ர அழிக்க,  

Home tab → Modify pael → Erase tool ஋ன்ப௅ெக் கிளிக் ௃சய்து ERASE கட்ை௅ர௅஬த் 

௄ெர்ந்௃ெடுக்கவும். (அல்யது) கட்ை௅ர லரியில் ERASE அல்யது E ஋ன ெட்ைச்சு ௃சய்஬வும். 

இப்௃பாழுது ௃சருகும் புள்ளி crosshair லிருந்து சிறி஬ சது஭஫ாக ஫ாறியிருக்கும். இது pickbox ஋ன்று 

அ௅றக்கப்படும். இென் ௄ொற்மம் தி௅஭யில் உள்ர எரு ௃பாரு௅ரத் ௄ெர்ந்௃ெடுக்கத் ெ஬ா஭ாக 

உள்ரது ஋ன்ப௅ெக் காட்டுகிமது. ௄஫லும் கட்ை௅ர லரியும் ௃பாரு௅ரத் ௄ெர்ந்௃ெடுக்கக் கூறும். 

11 

இதுல௅஭ ௄சமிக்காெ ௄காப்௅ப முெல் மு௅ம஬ாக ௄சமிக்கும் ௃பாழுது, ப஬ன்பாட்டுப் 

பட்டிப்பட்௅ையிலிருந்து Save அல்யது Save As“ ஋ன்ப௅ெக் கிளிக் ௃சய்ொல் ஋ன்ன ௄ொன்றும்?  

ஆட்௄ைா௄கடில் நீங்கள் ௃சய்ெ ௄ல௅ய௅஬ ௄சமிக்க,  

1. வி௅஭வு அணுகல் கருவிப்பட்௅ையில் உள்ர Save ௃பாத்ொ௅னக் கிளிக் ௃சய்஬ ௄லண்டும்.  

2. ல௅஭பைம் இதுல௅஭ ௄சமிக்கப்பைவில்௅ய ஋னில், SaveDrawing As உ௅஭஬ாைல் ௃பட்டி 

௄ொன்றும்.  

3. அதில் File name உ௅஭ப்௃பட்டியில் ல௅஭பைத்திற்கான ௃ப஬௅஭க் ௃காடுத்து Save 

௃பாத்ொ௅னக் கிளிக் ௃சய்஬வும். 

12 

ஆட்௄ைா௄கடில் எரு ௄காப்௅ப திமப்பெற்கான வி௅஭லான லழி ஋ன்ன?  

சிலப்பு நிமத்தில் உள்ர ப஬ன்பாட்டுப் ௃பாத்ொ௅னக் (A) கிளிக் ௃சய்ொல், ப஬ன்பாட்டுப் பட்டி 

௄ொன்றும். இந்ெ பட்டி஬ானது, புதி஬ ௄காப்௅ப உருலாக்குெல், ஌ற்கன௄ல உள்ர ௄காப்௅பத் 

திமத்ெல், நைப்புக் ௄காப்௅ப ௄சமித்ெல், நைப்பு ௄காப்௅ப ஫ற்௃மாரு ௃ப஬ரில், ௄லறு ௄காப்பு௅மயில் 

௄சமித்ெல், ௄லறு ௄காப்பு லடிலத்தில் ௄சமித்ெல் நைப்புக் ௄காப்௅ப அச்சிடுெல் ௄பான்ம ௄காப்பு 

௃ொைர்பு௅ை஬ கட்ை௅ரக௅ரக் ௃காண்டிருக்கும். 
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ஆட்௄ைா௄கட்டிலிருந்து ஋வ்லாறு ௃லளி௄஬மயாம்?  

உங்கள் ௄ல௅ய௅஬ ௄சமித்து ஆட்௄ைா௄கட்டிலிருந்து ௃லளி௄஬ம,  

1. ஆட்௄ைா௄கட் சன்னல் தி௅஭யில் ௄஫ல் லயது மூ௅யயிலுள்ர மூடு ௃பாத்ொனக் (X) கிளிக் 

௃சய்஬ ௄லண்டும்.  

2. திமந்திருக்கும் ௄காப்புகளில் ஌  னும் ஫ாற்மம் ௃சய்஬ப்பட்டிருந்ொல், ஆட்௄ைா௄கட் அ௅ெ 

௄சமிக்க ௄லண்டு௄஫ா அல்யது ௄சமிக்கா஫ல் மூை ௄லண்டு௄஫ா ஋ன்ப௅ெ கீழ்க்கண்ை 

உ௅஭஬ாைல் ௃பட்டியில் உள்ர௅ெப் ௄பான்று வினா ஋ழுப்பும். உங்கள் ௄ல௅ய௅஬ ௄சமிக்க 

Yes ௃பாத்ொ௅னக் கிளிக் ௃சய்஬ ௄லண்டும்.  

3. ஌ற்கன௄ல ௄சமிக்கப்பைாெ புதி஬ ல௅஭பை஫ாக இருந்ொல், ஆட்௄ைா௄கட் Save Drawing As 

஋ன்னும் உ௅஭஬ாைல் ௃பட்டி௅஬த் தி௅஭யில் காட்டும். பின்னர் ௄காப்௅ப ௄சமித்து 

ஆட்௄ைா௄கட்டிலிருந்து ௃லளி௄஬றும். 

பகுதி-இ 

III. எரு பத்தி஬ரவில் வி௅ை஬ளிக்கவும். 

1 

௃பாருள்க௅ர உருலாக்குலெற்கான ஌௄ெனும் மூன்று கட்ை௅ரக௅ரக் கூறு.  

• ௅யன் (Line) கட்ை௅ர௅஬க் ௃காண்டு ௄காடுகள் ல௅஭஬யாம்.  

• சர்க்கிள் கட்ை௅ர௅஬ப் (Circle) ப஬ன்படுத்தி எரு லட்ைம் ல௅஭஬ முடியும்.  

• RECTANG கட்ை௅ர, சரி஬ான ௄காண அரவுகளுைன் எரு ௃சவ்லகத்௅ெ எ௄஭ ௃பாருராக 

ல௅஭஬ லழி லகுக்கிமது.  

2 

வி௅சப்பய௅க மூயம் LINE, CIRCLE ஫ற்றும் ERASE ௄பான்ம கட்ை௅ரக௅ர ஋வ்லாறு வி௅஭லாக 

உள்ளிையாம்?  

• கட்ை௅ர லரியில் LINE ஋ன ெட்ைச்சு ௃சய்஬ ௄லண்டும். பின்னர் ஆ஭ம்ப x ஫ற்றும் y 

ஆ஬த்௃ொ௅யவுக௅ரக் ௃காடுக்க ௄லண்டும். பின்னர் முடிவு ஆ஬த் ௃ொ௅யவுக௅ரக் 

௃காடுக்க ௄லண்டும்.  

• கட்ை௅ர லரியில் CIRCLE ஋ன ெட்ைச்சு ௃சய்து ௅஫஬ப்புள்ளிக௅ர (x ஫ற்றும் y ஆ஬த் 

௃ொ௅யவுக௅ர) ௃காடுக்க ௄லண்டும். பின்னர் D (Diameter) ஋ன ெட்ைச்சு ௃சய்து விட்ைத்௅ெ 

உள்ளீை ௄லண்டும்.  

• கட்ை௅ர லரியில் ERASE அல்யது E ஋ன ெட்ைச்சு ௃சய்஬வும். அழிக்க ௄லண்டி஬ ௃பாருளின் 

மீது pickbox-஍ ௅லத்து கிளிக் ௃சய்஬ ௄லண்டும். ௃பாருளு௅ை஬ ௄காட்டின் ெடி஫ன் ௃லளிர் 

சாம்பல் நிமத்திற்கு ஫ாறும். அழிக்க ௄லண்டி஬ அ௅னத்துப் ௃பாருள்க௅ரயும் ௃ொைர்ந்து 

   ந்௃ெடுக்கயாம் நு௅றவு வி௅ச௅஬ அழுத்ெ ௄லண்டும். 

3 

LINE கட்ை௅ரயில் உள்ர Undo ௄ெர்வின் ப஬ன்க௅ர ஋ழுதுக.  

எரு ௄காடு ல௅஭யும் ௄பாது முடிவுப் புள்ளி௅஬த் ெலமாகக் குறிப்பிட்டுவிட்ைால், Undo கட்ை௅ர 

மூயம் க௅ைசி஬ாகக் குறிப்பிட்ை புள்ளி௅஬ நீக்கிவிட்டு, முந்௅ெ஬ கட்ைத்திற்குச் ௃சல்யயாம். இந்ெ 

விருப்பத்௅ெப் ப஬ன்படுத்ெ, கட்ை௅ர லரியில் Undo அல்யது U ஋னத் ெட்ைச்சு ௃சய்து நு௅றவு 

வி௅ச௅஬ அழுத்ெ ௄லண்டும்.  

4 

லட்ைங்க௅ர உருலாக்கும் பின்லரும் மு௅மக௅ர சுருக்஫ாக விலரி.  

அ. Centre and radius  

கட்ை௅ர லரியில் CIRCLE ஋ன ெட்ைச்சு ௃சய்து நு௅றவு ௃பாத்ொ௅ன அழுத்ெவும். பின்னர் 

கட்ை௅ர லரியில் ௅஫஬ப்புள்ளி௅஬ (x ஫ற்றும் y) குறிப்பிட்டு நு௅றவு ௃பாத்ொ௅ன ஆழுத்ெ 

௄லண்டும். பின்னர் ஆ஭த்தி௅ன உள்ளீட்டு நு௅றவு ௃பாத்ொ௅ன அழுத்ெ ௄லண்டும்.  

ஆ. Centre and diameter  

கட்ை௅ர லரியில் CIRCLE ஋ன ெட்ைச்சு ௃சய்து நு௅றவு ௃பாத்ொ௅ன அழுத்ெவும். பின்னர் 

கட்ை௅ர லரியில் ௅஫஬ப்புள்ளி௅஬ (x ஫ற்றும் y) குறிப்பிட்டு நு௅றவு ௃பாத்ொ௅ன ஆழுத்ெ 

௄லண்டும். பின்னர் கட்ை௅ர லரியில் D ஋ன ெட்ைச்சு ௃சய்து நு௅றவு ௃பாத்ொ௅ன அழுத்ெ 

௄லண்டும். இப்௄பாது விட்ை ஫திப்பி௅ன ெட்ைச்சு ௃சய்து நு௅றவுப் ௃பாத்ொ௅ன அழுத்ெ 

௄லண்டும். 
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பகுதி – ஈ 

IV. எரு பக்க அரவில் வி௅ை஬ளிக்கவும் 

1 

ஆட்௄ைா௄கட் இ௅ைமுகத்௅ெப் பற்றி விலரி.  

ஆட்௄ைா௄கட் 2016 இன் இ௅ைமுக஫ானது ரிப்பன்க௅ரயும், ப஬ன்பாட்டுப் பட்டிக௅ரயும் 

அடிப்ப௅ை஬ாகக் ௃காண்ைது. இந்ெ இ௅ைமுகத்தின் முக்கி஬஫ான அம்சம் ல௅஭க௅யப் பகுதியின் 

அரவு ௃பரி஬ொக இருக்கும்.  

ப஬ன்௃பாட்டுப் பட்டி (ApplicationMenu)  

சிலப்பு நிமத்தில் உள்ர ப஬ன்பாட்டுப் ௃பாத்ொ௅னக் (A) கிளிக் ௃சய்ொல், ப஬ன்பாட்டுப் பட்டி 

௄ொன்றும். இந்ெ பட்டி஬ானது, புதி஬ ௄காப்௅ப உருலாக்குெல், ஌ற்கன௄ல உள்ர ௄காப்௅பத் 

திமத்ெல், நைப்புக் ௄காப்௅ப ௄சமித்ெல், நைப்பு ௄காப்௅ப ௄ல௃மாரு ௃ப஬ரில், ௄லறு ௄காப்பு௅மயில் 

௄சமித்ெல், ௄லறு ௄காப்பு லடிலத்தில் ௄சமித்ெல், நைப்புக் ௄காப்௅ப அச்சிடுெல் ௄பான்ம ௄காப்பு 

௃ொைர்பு௅ை஬ கட்ை௅ரக௅ரக் ௃காண்டிருக்கும். ப஬ன்பாட்டுப் பட்டியின் ௄஫ல் பகுதியில் ௄ெைல் 

பட்௅ை (Search bar)  இைம் ௃பற்றிருக்கும்.  

ெ௅யப்புப் பட்௅ை (Title bar)  

ெ௅யப்புப் பட்௅ை஬ானது Autodesk AutoCAD 2016 ஋ன்னும் ௃஫ன்௃பாருளின் ௃ப஬௅஭யும், 

ெற்௄பா௅ெ஬ ல௅஭பைத்தின் ௃ப஬௅஭யும் ௃காண்டிருக்கும்.  

வி௅஭வு அணுகல் கருவிப்பட்௅ை (Quick Access Toolbar)  

இந்ெ கருவிப்பட்௅ை, சன்னல் தி௅஭யின் இைது ௄஫ல் ஏ஭த்தில் சிலப்பு நிம ௃பாத்ொ௅ன 

அடுத்துக் காணப்படும். இந்ெப் பட்௅ை Workspace ஫ற்றும் Undo/Redo கட்ை௅ரகளுக்கும், 

ப஬ன்பாட்டுப் பட்௅ையில் உள்ர அ௅னத்து ௄காப்புக் கட்ை௅ரகளுக்கும் பணிக்குறிக௅ரக் 

௃காண்டிருக்கும்  

ரிப்பன் (Ribbon)  

ஆட்௄ைா௄கட் 2016 சன்னல் தி௅஭யின் ௄஫ல் பகுதியிலுள்ர ெ௅யப்புப் பட்௅ைக்கு கீழ் உள்ர 

பகுதி ரிப்பன் ஆகும். இந்ெ ரிப்பன் இ஭ண்டு பகுதிக௅ர உ௅ை஬து. Ribbon Tab, Ribbon Panel  

Start ௃ொகுதி  

Start ௃ொகுதி௅஬க் கிளிக் ௃சய்ெவுைன், ஆட்௄ைா௄கட் 2016 இன் ௃ொைக்கத் தி௅஭ ஫றுபடியும் 

௄ொன்றும். அென் மூயம் புதி஬ ல௅஭பைத்௅ெத் ௃ொைங்குெல், ஌ற்கன௄ல உள்ர ல௅஭பைத்௅ெ 

திமத்ெல் ௄பான்ம ௃ச஬ல்க௅ரச் ௃சய்஬வும்.  

File ௃ொகுதி  

ரிப்பனுக்கு கீ௄ற File ௃ொகுதி பட்௅ை உள்ரது. திமக்கப்படும் எவ்௃லாரு ௄காப்பிற்கும் எரு 

௃ொகுதி உருலாக்கப்படும். File ௃ொகுதியின் மூயம் எரு ல௅஭பைக் ௄காப்பிலிருந்து ஫ற்௃மாரு 

ல௅஭பைக் ௄காப்பிற்கு ஋ளிொக ொவிச் ௃சல்ய முடியும்.  

ல௅஭பைப் பகுதி  

தி௅஭யின் ௃பரு஫ரவுப் பகுதி ல௅஭பைப் பகுதி (Drawing Area) ஆகும். இதில் ௃பாருள்க௅ரயும், 

முப்பரி஫ாண ல௅஭க௅யக௅ரயும் ஋ளிொக ல௅஭஬ முடியும்.  

கட்ை௅ர சார஭ம் (Command Window)  

ப஬ன்பாட்டு சார஭த்தின் அடிப்பகுதியில்,  நி௅ய௅஫ப் பட்௅ைக்கு (Status bar) ௄஫யாக கட்ை௅ர 

சார஭ம் அரந்திருக்கும். இந்ெச் சார஭த்தில் ௃பாதுலாக மூன்று உ௅஭ லரிகள் காணப்படும். முெல் 

இ஭ண்டு லரிகள், இெற்கு முன் ப஬ன்படுத்தி஬ கட்ை௅ரக௅ரக் காட்டும். க௅ைசி லரி஬ானது 

கட்ை௅ர லரி ஆகும். கட்ை௅ரச் சார஭ம் ௄ொன்மா விட்ைால் Ctrl + 9 ஋ன்னும் வி௅சக௅ர அழுத்தி 

௄ொன்மச் ௃சய்஬யாம்.  

சமீபத்தி஬ உள்ளீடு (Recent input)  

‘Command’: prompt இல் நாம் க௅ைசி஬ாக ெட்ைச்சு ௃சய்ெ 20 கட்ை௅ரக௅ர, ஆட்௄ைா௄கட் 

நி௅னவில் ௃காண்டிருக்கும். இந்ெ கட்ை௅ரகளுக்கு ‚Recent Input‛ ஋ன்று ௃ப஬ர்.  

UCS பணிக்குறி  

ல௅஭பைப் பகுதியின் கீழ் இைது மூ௅யயில் உள்ர L  லடில ௄காட்டிற்கு UCS பணிக்குறி 
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஋ன்று ௃ப஬ர். UCS ஋ன்பது ‚User Coordinate System‛ ஋ன்பென் குறுக்க஫ாகும்.  

உயவுெல் பட்௅ை (Navigation Bar)  

உயவுெல் பட்௅ை஬ானது ல௅஭பைப்பகுதியில் இருக்கும். இது உயவுெலுக்கான கருவிக௅ரக் 

௃காண்டிருக்கும்.  

நி௅ய௅஫ப் பட்௅ை (Status Bar)  

கட்ை௅ர லரிக்கு கீ௄ற நி௅ய௅஫ப்பட்௅ை இருக்கும். சா஭த்தின் கீழ் லயது மூ௅யயில் உள்ர 

பட்௅ை ப஬ன்பாட்டு நி௅ய௅஫ப் பட்௅ை (Application Status Bar) ஆகும்.  

ல௅஭பை ஆ஬த் ௃ொ௅யவுகள் (Drawing Coordinates)  

ஆட்௄ைா௄கட் 2016 இல் டி஭ாயிங் ௄காஆர்டி௄னட் ௃பாத்ொன் ொன௅஫லாக 

஫௅மக்கப்பட்டிருக்கும். கஸ்ை௅஫௄ளசன் பட்டி௅஬ப் (Customization menu) ப஬ன்படுத்தி 

அ௅ெக் காண்பிக்க முடியும்.  

஫ாைல் (MODEL)  

ல௅஭பைம் ல௅஭லெற்காக ஫ாைல் பகுதியில் பணிபுரியும் ௃பாழுது, ஫ாைல் (MODEL) ௃பாத்ொன் 

ொன௅஫லாகத் ௄ெர்ந்௃ெடுக்கப்பட்டிருக்கும்.  

பணித்ெரம் (Workspace)  

பணித்ெரம் ஋ன்பது ல௅஭பைப் பகுதியின் இைம் ஫ற்றும் ௄ொற்மம், அ௅னத்துவிெ பட்டிகள், 

௃பாத்ொன்கள், ௃பாத்ொன் ௃ொகுதிகள் அைங்கி஬ எரு முழு௅஫஬ான ப஬னர் இ௅ைமுகம் 

ஆகும். 
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கட்ை௅ரச் சார஭ம் பற்றி விலரி.  

கட்ை௅ர சார஭ம் (Command Window)  

ப஬ன்பாட்டு சார஭த்தின் அடிப்பகுதியில், நி௅ய௅஫ப் பட்௅ைக்கு (Status bar) ௄஫யாக கட்ை௅ர 

சார஭ம் அ௅஫ந்திருக்கும். இந்ெச் சார஭த்தில் ௃பாதுலாக மூன்று உ௅஭லரிகள் காணப்படும். 

முெல் இ஭ண்டு லரிகள், இெற்கு முன் ப஬ன்படுத்தி஬ கட்ை௅ரக௅ரக் காட்டும். க௅ைசி 

லரி஬ானது கட்ை௅ர லரி ஆகும். கட்ை௅ரச் சார஭ம் ௄ொன்மாவிட்ைால் Ctrl + 9 ஋ன்னும் 

வி௅சக௅ர அழுத்தி ௄ொன்மச் ௃சய்஬யாம். கட்ை௅ர லரியில் ௃சருகும் புள்ளி உள்ர இைத்தில் 

கட்ை௅ரக௅ர உள்ளிை முடியும். இது Command: prompt ஋ன அ௅றக்கப்படும். கட்ை௅ரயின் 

முெல் ஋ழுத்௅ெ ெட்ைச்சு ௃சய்ெவுைன், அந்ெ ஋ழுத்தில் ௃ொைங்கும் அ௅னத்துக் கட்ை௅ரகளின் 

பட்டி஬ல் ௄ொன்றும்.  

குறிப்பு  : கட்ை௅ர லரியில் ஫திப்புக௅ர உள்ளிட்ைவுைன் நு௅றவு வி௅ச௅஬ அழுத்ெ ௄லண்டும். 

இந்ெச் சார஭த்௅ெ கிளிக் ௃சய்து இழுத்து தி௅஭யில் ஋ங்கு ௄லண்டு஫ானாலும் ௅லக்கயாம். 

அர௅லயும் ஫ாற்மயாம். கட்ை௅ர௅஬ உள்ளிடும் ௄பாது சிறி஬ ஋ழுத்தி௄யா, ௃பரி஬ ஋ழுத்தி௄யா 

அல்யது இ஭ண்டும் கயந்௄ொ ௃காடுக்க முடியும். கட்ை௅ர லரியில் ெட்ைச்சு ௃சய்யும் ௃பாழுது பி௅ற 

஌ற்பட்ைால், BACKSPACE வி௅ச மூயம் அழித்துவிட்டு சரி ௃சய்஬யாம். ESC வி௅ச௅஬ ஋ந்ெ 

௄ந஭த்திலும் அழுத்ெ முடியும். எரு ௃ச஬ல் ௃ச஬ல்பாட்டில் இருக்கும் ௃பாழுது ESC வி௅ச௅஬ 

அழுத்தினால், அது அக்கட்ை௅ர௅஬ முடிவுக்குக் ௃காண்டு லரும்.  

ஆட்௄ைா௄கடில் முன்னொகப் ப஬ன்படுத்தி஬ கட்ை௅ர௅஬த் திரும்பவும் ப஬ன்படுத்ெ 

௄லண்டு௃஫னில், Command: prompt இல் நு௅றவு வி௅ச (ENTER) அல்யது இ௅ை௃லளி 

வி௅ச௅஬ (spacebar) அழுத்ெ ௄லண்டும். ஫ாமாக சுட்டி௅஬ லயது கிளிக் ௃சய்லென் மூயம் 

௄ொன்றும் பட்டியில், Repeat ஋ன்னும் விருப்பத்௅ெ ௄ெர்ந்௃ெடுக்கயாம்.  

சமீபத்தி஬ உள்ளீடு (Recent input)  

‘Command’: prompt இல் நாம் க௅ைசி஬ாக ெட்ைச்சு ௃சய்ெ 20 கட்ை௅ரக௅ர, ஆட்௄ைா௄கட் 

நி௅னவில் ௃காண்டிருக்கும். இந்ெ கட்ை௅ரகளுக்கு ‚Recent Input‛ ஋ன்று ௃ப஬ர். கட்ை௅ரகளின் 

பட்டி஬௅யக் காண விரும்பினால் சுட்டி௅஬ லயது கிளிக் ௃சய்து லரும் பட்டியில் Recent input 

஋ன்ப௅ெக் கிளிக் ௃சய்஬ ௄லண்டும். ஆட்௄ைா௄கட் இெற்கு முன் ப஬ன்படுத்தி஬ கட்ை௅ரக௅ரயும், 

ஆ஬த்௃ொ௅யவு உள்ளீடுக௅ரயும் (Coordinate Inputs) து௅ணப்பட்டி஬லில் காட்டும்.  
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௃஭க்ைாங்கல் ௃பாரு௅ரப் பற்றி ஋ழுதுக. ஆட்௄ைா௄கடில் ௃சவ்லகம் ல௅஭லெற்கான 

லழிமு௅மக௅ரக் கூறு.  

௃சவ்லகம் ல௅஭ெல்  

லடில௅஫ப்பாரர்கள் ப஬ன்படுத்தும் அடிப்ப௅ை லடிலங்களில் என்று ௃சவ்லகம் ஆகும். ௅யன் 

கட்ை௅ர௅஬ப் ப஬ன்படுத்தியும் ௃சவ்லகம் ல௅஭஬ முடியும். ஆனால் அதில் சிய கு௅மபாடுகள் 

உள்ரன.  ஋டுத்துக்காட்ைாக, ௄காண அரவுகள் 90 டிகிரி உள்ரனலா ஋ன சரிபார்க்க 

௄லண்டும். ௄஫லும் எவ்௃லாரு ௄காடும் ெனித்ெனி ௃பாருராக இருக்கும். எரு ௄காட்டின் மீது 

கிளிக் ௃சய்ொல் அந்ெ ௄காடு ஫ட்டு௄஫ ௄ெர்வு ௃சய்஬ப்படும். ஫ற்ம ௄காடுகள் ௄ெர்வு 

௃சய்஬ப்பைாது. ஆ௅க஬ால் ஆட்௄ைா௄கட் 2016 இல் உள்ர RECTANG கட்ை௅ர, சரி஬ான 

௄காண அரவுகளுைன் எரு ௃சவ்லகத்௅ெ எ௄஭ ௃பாருராக ல௅஭஬ லழி லகுக்கிமது. இந்ெ 

RECTANG கட்ை௅ர௅஬ப் ப஬ன்படுத்தி ல௅஭஬ப்பட்ை ௃சவ்லகத்தின் ஋ந்ெ௃லாரு இைத்திலும் 

கிளிக் ௃சய்து முழு ௃சவ்லகத்௅ெயும் ௄ெர்ந்௃ெடுக்க முடியும்.  

சுட்டுக்குறியின் மூயம் ௃சவ்லகத்தின் மு௅னக௅ரத் ௄ெர்ந்௃ெடுத்து ௃சவ்லகம் ல௅஭ெல்  

1. Command: RECTANG (அல்யது) REC (நு௅றவு வி௅ச௅஬ அழுத்ெவும்).  

2. கட்ை௅ர லரியில் கீழ்க்கண்ைலாறு ௄ொன்றும்.  

RECTANGLE  Specify first corner point or [Chamfer/ Elevation/Fillet/Thickness/Width]:  

௃சவ்லகத்தின் முெல் மு௅ன (P1) ல௅஭஬ ௄லண்டி஬ இைத்திற்கு சுட்டுக்குறி௅஬ நகர்த்தி 

சுட்டியின் இைது ௃பாத்ொ௅னக் கிளிக் ௃சய்஬வும்.  

3. கட்ை௅ர லரியில் கீழ்க்கண்ைலாறு ௄ொன்றும்.  

Specify other corner point or [Area / Dimensions / Rotatio]:  

௃சவ்லகத்தின் முெல் மு௅னயிலிருந்து சுட்டி௅஬ மூ௅யவிட்ைம் லழி஬ாக நகர்த்தி, 

஫றுமு௅னயில் (P2) சுட்டியின் இைது ௃பாத்ொ௅னக் கிளிக் ௃சய்஬வும். இப்௃பாழுது ௃சவ்லகம் 

ல௅஭஬ப்பட்டிருக்கும். 
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(a)                                                          . 

        - A4 

               - 4 

            1.25                  0.75       

(b)                    . 

HAPPINESS 

Happiness is often confused with fun, good living, and riches. Sometimes fun is equated with 

happiness. Fun is what we experience while doing an activity, whereas happiness is a residual 

and long-lasting feeling. The path to happiness is long and full of challenges. Happiness requires 

life-long pursuit. 

(c) HAPPINESS                             18      ,          Arial, 

    ,                             . 

(d)                             . 

(a) Font   - Arial 

(b) Font size  - 12 

(c) Alignment  – Justified 

(d) Leading  – 20 

(e)        ‘happiness’                . 

       

                                                     

         

       

1. Start All Programs  Adobe  PageMaker 7.0  Adobe PageMaker 7.0            

                                       .                  

                              . 

 
2.            File  New                  . (    ) Ctrl + N      

                             .    Document Setup         

             . 
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 Page Size                           A4                           . 

 Number of pages            4          . 

                             . 

Inside – 0.75 inches 

Outside – 0.75 inches 

Top – 1.25 inches 

Bottom – 0.75 inches 

 
3. OK                    .                  Untitled–1               

                 . 
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4.                                            .       ழ 

                               .  

HAPPINESS 

Happiness is often confused with fun, good living, and riches. Sometimes fun is equated with 

happiness. Fun is what we experience while doing an activity, whereas happiness is a residual 

and long-lasting feeling. The path to happiness is long and full of challenges. Happiness requires 

life-long pursuit. 

5.                  ‘HAPPINESS’                   . Character Control Palette 

             Arial,                 18      , Leading 22          . 

Bold                     .                Shift + Ctrl + C          

                . 

 

6.                                    . Character Control Palette     

         Arial,                12      , Leading 20          .     

             Shift + Ctrl + J                          . 

 
 

7.        ‘happiness’                            Ctrl + S       

                       File  Save                  . Save publication 

                   . File name            ‘happiness’               Save 

                    . 
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HAPPINESS 

Happiness is often confused with fun, good living, and riches. Sometimes fun is equated with 

happiness. Fun is what we experience while doing an activity, whereas happiness is a residual 

and long-lasting feeling. The path to happiness is long and full of challenges. Happiness requires 

life-long pursuit. 
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                                                    . 

 
       

                                                 

       

1. Start  All Programs  Adobe  PageMaker 7.0  Adobe PageMaker 7.0            

                                       . 

2.            File  New                  . (    ) Ctrl + N      

                             .    Document Setup         

             . 

3. OK                    .         Untitled–1                    

            . 

4.                       100 mm x 100 mm                        . 

         (Cyan)             . tint       25               .         

                     . 

 
5.           100 mm x 15 mm                               .     

     (black)             .                  (Cyan)                     

               .                              . 
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6.                                                              

          .          ‚Student Notice Board‛                     . 

                             (      )      .                  

        Ctrl + A                                            . 

Character Control palette                20               . Bold 

                   . Reverse                                

          .                     Shift + Ctrl + C               

                    .                                    

            . 
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                                            . 

 
       

                                                    . 

       

1. Start  All Programs  Adobe  PageMaker 7.0  Adobe PageMaker 7.0     

                                              . 

2.            File  New                  . (    ) Ctrl + N      

                             .    Document Setup         

             . 

3. OK                    .         Untitled–1                    

            . 

 
4.                 Inches      Millimeters         . 

           File  Preferences  general                        . 

(    )            Ctrl + K             .         Preferences 

                   .     Measurements      Vertical ruler       

           Millimeters                   . 
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5.                                                     . 

6. Control Palette    width 95 mm      height 55 mm            . 

 
7.                                .                        

                                                    

           . 

8.                 ,                             . Control Palette 

                                              .          

                 . 

 
9.       7 ஐ              .                    ,              

               . Control Palette                           

                    .                           .           

                                                . 
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10.       7 ஐ              .                     ,           

                  . Control Palette                           

                    .                           . 
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                                (Label)       . 

 

       

                                      (Label)         . 

       

1. Start  All Programs  Adobe  PageMaker 7.0  Adobe PageMaker 7.0     

                                              . 

2.            File  New                  . (    ) Ctrl + N      

                             .    Document Setup         

             . 

3. OK                    .         Untitled–1                    

            . 

4.                 Inches      Millimeters         . 

           File  Preferences  general                        . 

(    )             Ctrl + K             .         Preferences 

                   .     Measurements      Vertical ruler       

           Millimeters                   . 

 

5.                                                    . 

6. Control Palette    width 100 mm      height 40 mm            . 

7.               Element  Rounded corners                  . 

8. Rounded corners                                              . 

                            . 

9.                               ,                           

        . 

10. Name :                     ழ              . 

STD :                     ழ              . 
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Section :                     ழ              . 

School :                     ழ              . 

Subject :                     ழ              . 

11.                                         . 

12.            Type  Indents / Tabs                  . (    ) 

           Ctrl + I             . 

13.     tab ஐ 90 mm              . leader                        

                              .      Apply               

      . 

 
14.                                    . 
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                      ழ                          . 

 
       

           (Envelope tool)                                    . 

       

1. Start  All Programs  CorelDRAW Graphics Suite 2018  CorelDRAW 2018     

                                  . 

2. Welcome Screen            New Document                     . 

3.         Create a New Document                    . 

4.     Ok                     . 

5.                      . (    )            F8             . 

6. ‚DesktopPublishing‛                         . 

 
7. Pick                                 . 

 
8.                     . 
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9.                                 .                               

             .           ழ                   . 
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                      ழ                          . 

 

       

                                              . 

       

1. Start  All Programs  CorelDRAW Graphics Suite 2018  CorelDRaw 2018     

                                  . 

2. Welcome Screen            New Document                     . 

3.         Create a New Document                    . 

4.     Ok                     . 

5.                     . (    )            F7             . 

6.                 .                         . 

7.                                       . 

8.                                         . 

9.                             70%                   . 

10.                    75               ,                    . 

11.                                        . 

      

 
    

                       . 

www.Padasalai.Net                                                                   www.CBSEtips.in

Kindly send me your study materials to our email id - padasalai.net@gmail.com

Pa
da

sa
la

i.N
et

Pa
da

sa
la

i.N
et

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://www.padasalai.net/
https://www.padasalai.net/


 
 

 50 M.Sc.,M.Ed.,M.Phil.,  

 

 
    

  ழ                                                  

                           . 

 

       

                                                     

                    . 

       

1.         AutoCAD 2016-English                                 

2016ஐ       . (    ) 

Start  All Programs  Autodesk  AutoCAD 2016 > AutoCAD 2016-English     

                         2016ஐ       . 

2. Drafting&Animation                                   acad.dwt 

                                     . 

3.                 Zoom All                 . 

4.                 Grid ஐ OFF       . 

5.                  OFF       . 

6.       Home  Draw  Line                      . (    )       

     LINE      L                 .   ழ                       

                        . 

Command: LINE↵ 

Specify first point: 55,100↵ 

Specify next point or [Undo]: 120,100↵ 

Specify next point or [Undo]: 120,70↵ 

Specify next point or [Close/Undo]: 230,70↵ 

Specify next point or [Close/Undo]: 230,100↵ 

Specify next point or [Close/Undo]: 295,100↵ 

Specify next point or [Close/Undo]: 295,210↵ 

Specify next point or [Close/Undo]: 275,235↵ 

Specify next point or [Close/Undo]: 80,235↵ 

www.Padasalai.Net                                                                   www.CBSEtips.in

Kindly send me your study materials to our email id - padasalai.net@gmail.com

Pa
da

sa
la

i.N
et

Pa
da

sa
la

i.N
et

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://www.padasalai.net/
https://www.padasalai.net/


 
 

 51 M.Sc.,M.Ed.,M.Phil.,  

 

pecify next point or [Close/Undo]: 55,210↵ 

Specify next point or [Close/Undo]: C↵ 

7. Line-example1.dwg                         . 
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1.             AutoCAD-2016 English                        

         2016ஐ       . (    ) 

Start  All Programs  Autodesk  AutoCAD 2016  AutoCAD 2016-English     

                         2016ஐ       . 

2. Drafting&Animation                                    acad. dwt 

                                     . 

3.                 Zoom All                 . 

4.                 Grid ஐ OFF       . 

5.                  OFF       . 

6.       Home  Draw  Line                      . (    )       

     LINE      L                 .   ழ                       

                        . 

Command: LINE↵ 

Specify first point: 100,100 ↵ 

Specify next point or [Undo]: @50,0 ↵ 

Specify next point or [Undo]: @0,20 ↵ 

Specify next point or [Close/Undo]: @100,0 ↵ 

Specify next point or [Close/Undo]: @0,-20 ↵ 

Specify next point or [Close/Undo]: @50,0 ↵ 

Specify next point or [Close/Undo]: @0,120 ↵ 

Specify next point or [Close/Undo]: @-50,0 ↵ 

Specify next point or [Close/Undo]: @0,-20 ↵ 

Specify next point or [Close/Undo]: @-100,0 ↵ 

www.Padasalai.Net                                                                   www.CBSEtips.in

Kindly send me your study materials to our email id - padasalai.net@gmail.com

Pa
da

sa
la

i.N
et

Pa
da

sa
la

i.N
et

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

www.Padasalai.Net

https://www.padasalai.net/
https://www.padasalai.net/


 
 

 53 M.Sc.,M.Ed.,M.Phil.,  

 

Specify next point or [Close/Undo]: @0,20 ↵ 

Specify next point or [Close/Undo]: @-50,0 ↵ 

Specify next point or [Close/Undo]: c ↵ 

8. Line-example2.dwg                         . 
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1.             AutoCAD-2016 English                        

         2016ஐ       . (    ) 

Start  All Programs  Autodesk  AutoCAD 2016  AutoCAD 2016-English     

                         2016ஐ       . 

2. Drafting & Animation                                    acad. dwt 

                                     . 

3.                 Zoom All                 . 

4.                 Grid ஐ OFF       . 

5.                  OFF       . 

6.       Home  Draw  Line                      . (    )       

     LINE      L                 .   ழ                      

                        . 

Command: LINE↵ 

Specify first point: 50,50↵ 

Specify next point or [Undo]: @110<0↵ 

Specify next point or [Undo]: @20<90↵ 

Specify next point or [Close/Undo]: @80<120↵ 

Specify next point or [Close/Undo]: @30<180↵ 

Specify next point or [Close/Undo]: @80<240↵ 

Specify next point or [Close/Undo]: C↵ 

7. Line-example3.dwg                         . 
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1.             AutoCAD -2016English                        

         2016ஐ       . (    ) 

Start  All Programs  Autodesk  AutoCAD 2016  AutoCAD 2016-English     

                         2016ஐ       . 

2. Drafting & Animation                                    acad. dwt 

                                     . 

3.                 Zoom All                 . 

4.                 Grid ஐ OFF       . 

5.                   OFF       . 

6.       Home  Draw  Line                      . (    )       

     LINE      L                 .   ழ                        

                        . 

Command: LINE↵ 

Specify first point: 2,1↵ 

Specify next point or [Undo]: 2,5↵ 

Specify next point or [Undo]: 7,5↵ 

Specify next point or [Close/Undo]: 7,4↵ 

Specify next point or [Close/Undo]: 4,4↵ 

Specify next point or [Close/Undo]: 3,3↵ 

Specify next point or [Close/Undo]: 4,2↵ 

Specify next point or [Close/Undo]: 7,2↵ 

Specify next point or [Close/Undo]: 7,1↵ 

Specify next point or [Close/Undo]: C↵ 

7. Line-example4.dwg                         . 
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